
Saber® Release Notes for Version Y-2006.06-SP2

This document is protected by copyright.

These release notes present the latest information about Saber Version 
Y-2006.06-SP2 in the following sections:
■ New Features, Enhancements, and Changes in Y-2006.06-SP2
■ Resolved STARs in Y-2006.06-SP2

This document also contains the following release notes:
■ Saber® Release Notes for Version Y-2006.06-SP1
■ Saber® Release Notes for Version Y-2006.06
■ CosmosScope Release Notes for Version Y-2006.06
■ CosmosScope Release Notes for Version X-2006.03

New Features, Enhancements, and Changes in Y-2006.06-SP2

Version Y-2006.06-SP2 provides new features, enhancements, and changes as 
described in the following sections:
■ Saber Harness Design Update
■ Behavioral Change to Variants in Saber Harness (STAR 9000099645)
■ MAST Template Encryption Utility
■ Thermal Impedance Tool Enhancements (STAR 9000003211)
■ Battery Tool Enhancements (STAR 9000142958)
■ Updates to Co-Simulations, Frameway Integrations and Interfaces
■ New Models
■ New Component Models
■ Dynamic Thermal Alternator with Charging System Loads and Battery 

Example (STAR 9000132326)
■ Saber Quick Start Enhancements
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Saber Harness Design Update

The purpose of Design Update is to make the data in a design consistent with 
the data in the source databases. Previously, updates to the database were not 
propagated to the designs that used those elements.

Understanding the Design Update Process
To update a design, you choose the properties for which you want the latest 
information: Ref, Cable, Passive, Shell and Wire properties. If you use CVC, 
you must have at least one sheet checked out. 

The design is searched for elements that need updating. You are first 
presented with a preview of the lists that need updating, as shown in Figure 1 
on page 3.
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Figure 1 Design List Preview

After you update the lists, you are presented with a preview of all the possible 
changes to the design, as shown in Figure 2 on page 4.

Properties that need updating are listed in the Element Update tab. The old 
value, if there was one, is listed and the new value, if there will be one, is listed 
next to the property. In the example shown in Figure 2, the proposed changes 
are as follows:
■ L0:Front wire will get a new color property with a value of Red and the cost 

property will be changed from 1 to 1.2.
■ The area property for new_wire:REAR will change the value editor to Wire, 

but the value will not change.
■ The value of the weight property for the Bulkhead_plug shell will change 

from 10 to 15.
3

New Features, Enhancements, and Changes in Y-2006.06-SP2



Synopsys Release Notes
Saber Version Y-2006.06-SP2 
■ The foo property for the abc part assigned on cavity 1 of the Bulkhead_plug 
shell will be removed.

■ APS (automatic part selection) was run and the assemblies property for the 
abcd part at shell MC1:One, cavity 1 was added with a value of assemby4.

The change in the assemblies property is different than other properties. 
The Old Column shows the assemblies to be removed and the New Column 
shows the assemblies to be added. Assemblies that do not change are not 
shown.

Figure 2 Design Update Preview
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If the design you are working with is under version control, the Check Out tab 
indicates if there are files or sheets that need to be checked out to accomplish 
all the proposed changes, as shown in Figure 3. 

Figure 3 Design Update Check Out Tab

In the example shown in Figure 3, The Lamps.ai_lst, sheet2, and sheet3 need 
to be checked out to make all the changes shown on the Element Update tab. 
Sheet2 is currently checked out by User2. 

A preliminary search of the design and the associated databases may indicate 
problems. To see the problems, click the Errors tab, as shown in Figure 4 on 
page 6. 
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Figure 4 Design Update Errors Tab 

In the example shown in Figure 4, there are a number of errors. The parts will 
not be updated in the design.

To save reports, from the File menu, select Save. Enter the name and location 
of the text file and click OK.

If you click Update, the files and sheets needed to accomplish the update will 
be checked out and the changes will be made. After the changes are made, 
you see a report of the changes, as shown in Figure 5.
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Figure 5 Design Update Results 

The Check Out tab shows whether files or sheets were successfully checked 
out or not.

If there were errors during the update process, they will be posted to the Errors 
tab, as shown in Figure 6 on page 8.
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Figure 6 Design Update Errors Tab
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When working on a design under version control, files and drawings checked 
out by other users cannot be updated. It is possible that while making changes 
to a sheet or drawing, a change needs to be made to the design. If the design is 
not checked out, these changes will not be made.

Understanding the Design Update Colors and Icons
Table 1 describes the colors used in the Design Update window. 

Table 2 describes the icons used in the Design Update window.

Table 1 Design Update Colors

Color Definition

Red A property or attribute will be removed.

Green A property or attribute will be added.

Blue A property or attribute will be modified.

Table 2 Design Update Icons

Icon Definition

The file or drawing is checked out by another user and cannot be updated.

The file or drawing is not checked out by another user and can be updated.

The value of the property or attribute will be updated.

This property or attribute will be added.

Assigns the correct value editor. The value may or may not be changed.

The property or attribute will be removed.

The property or attribute could not be updated because the file or drawing 
could not be checked out.

The part for this element cannot be identified in the parts database. This may 
occur for the following reasons:
■ There is no part in the database with a matching value in the part_no 

property
■ There is more than one part in the database with a matching value in the 

part_no property
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Updating a design
To update a design with the latest information:

1. From the Edit menu, select Design Update.

You’ll see the Design Update dialog box. 

2. Select the databases from which you want to update information.

3. Click OK. 

If there are any lists that need updating, you’ll see a preview of what could 
be changed. For an example, see Figure 1 on page 3.

4. Click Yes to update the lists.

If there are any design elements that need updating, you’ll see a preview of 
what could be changed. For an example, see Figure 2 on page 4.

If nothing needs to be updated, you’ll see the following dialog: 

5. If there are elements that need updating, review the information on the 
Check Out tab and the Errors tab. For examples, see Figure 3 on page 5 
and Figure 4 on page 6.

6. Do one of the following:

• To update the design, click Update at the bottom of the window.
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• To abort the design update process, click Cancel.

• To save a report of the proposed changes, click Save.

When the update process is complete, you’ll see a summary of the changes.

7. To save a report of the changes, click Save at the bottom of the window.

8. To close the Update Design window, click Close.

Known Issues with Design Update

Saber Harness crashes when updating shells with the same ref and 
harness values. The crash only occurs in designs created in releases prior 
to Y-2006.06-SP2. To work around this problem, create unique ref and harness 
values for shells before using Design Update. You can use DRC to check that 
shells have a unique reference.

Property description overwritten by pdb The description property for Refs 
are updated based on the ref list. If a part database has a description defined 
for the part, the description is overwritten by what the value defined in the part 
database. For example, if the shell database has a description value defined for 
the part, the shell’s description property of the shells using this part are 
overwritten by the value defined in the shell database. Furthermore, when the 
description property is defined in cable slots, the wire that is assigned to this 
slot will be overwritten.

To work around this problem, do one of the following:
■ Do not define the description property in the part databases.
■ Use Design Update to update only type Refs after updating all other types.

Error not reported when the shell_* property is wrong When creating 
component mounted shells, the component symbol must have a shell_* 
property, where * is the name of the shell. The value of this property should be 
the part_no value of the connector on this component. In some cases, the 
value of this property becomes invalid after changes in the shell database, but 
the component mounted shells are still valid. In these situations, there is no 
error when querying the design. The error is reported when the design is 
updated.

Shell properties with no value changed without notification When 
updating shells, some properties may change from empty to *opt*. This change 
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is not reported. There are no consequences to this change because an empty 
property and *opt* are treated the same.

Warning dialogs open when updating shells A warning dialog opens when 
updating shells in the following situations:
■ The component’s shell_* property is invalid
■ Cavities are removed from a pair of inline connectors and there are symbols 

assigned to these cavities
■ Cavities are removed from a component mounted shell and there are ports 

mapped to these cavities

The shells are updated correctly. If you see these dialogs, you can close them.

Cable wire property change reported in incorrect section Design Update 
unassigns a wire from a cable when the wire slot it is assigned to no longer 
exists. The Cable property of this wire is also removed, if it exists. This action is 
reported in the Cable Slot section instead of the Wire section. The cable and 
wire are updated correctly.

Behavioral Change to Variants in Saber Harness 
(STAR 9000099645)

In prior releases, objects that had no variant assignment or that used the *opt* 
variant were automatically assumed to be common elements and were used in 
the Assembly Tool. In Y-2006.06-SP2, the behavior of the Assembly Tool filter 
has changed from matching anything to matching nothing. As a result, all 
common elements need to have a property that indicates they are common or 
the Assembly Tool will filter them out and not use them.

This change is the result of changes to the design rule checks to make them 
more deterministic. Before this change, it was not possible to determine 
whether *opt* was empty because the object was common or because it was 
accidently left empty. 

Changes to the filter will at a minimum affect the following features:
■ Export from Harness to Bundle
■ Bundle tool
■ Export DSI
■ Any place where data needs to be extracted with filters
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MAST Template Encryption Utility

The Encryption tool enables you to encrypt templates so that at least portions 
of them are made unreadable by the end user. Encryption does not restrict 
access to the template and any user with access to the Saber simulator can 
use the template and view the unencrypted portions of the template.

The Encryption tool user interface allows you to read a template into a text 
editor and select which portions of the file you want to encrypt. The tool 
ensures that all of the necessary constructs are in place and then calls the 
ai_encryp utility. This utility was only available as a command line utility.

The portions of the template that you want to encrypt use the following three 
lines of text in the template:

!crypt_start
pack 002
!crypt_end

The !crypt_start and pack 002 lines are placed at the beginning of the text to be 
encrypted and must be on two contiguous lines. The !crypt_end line is placed 
at the end of the portion to be encrypted but must be before the final closing 
brace of the template. You can encrypt several sections of a template, but they 
can not be nested.

Getting Started with the Encryption Tool
The Encryption tool relies on the ai_encryp utility which resides in the 
Saber/bin directory. You must include this directory in your PATH variable prior 
to invoking Sketch. You must also have write permissions in the source file 
directory. 

To start the Encryption Tool:

1. Open the Model Architect panel by doing one of the following:

• From the Tools menu, select Model Architect.

• From the toolbar at the bottom of the screen, click the Model Architect 

icon. 

2. From the Model Architect tools menu, select Encryption Tool.

The encryption tool is intended solely for the purpose of encrypting MAST 
templates. When you open a file in the tool, it checks to ensure that the file has 
the required structure. It checks for the keyword “template” in a 
non-commented line; this is the template header line. If the tool finds a template 
13
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header line, it searches it for the keyword “encrypted”. If the word encrypted 
does not appear in the template header line the tool automatically inserts it. 
The tool does not allow the text of the file to be edited other than the insertion 
of the encryption constructs.

Normally, the ai_encryp utility requires the unencrypted file to have a .dec 
extension and the resulting encrypted file is written with a .sin extension. The 
Encryption tool interface accepts either extension for the input file. It writes a 
.dec file to the working directory prior to calling the ai_encryp utility. 

The Edit > Tool Preferences> Save Backup command allows you to save a 
backup copy of the input file before any operations are performed on it. If 
selected, this option saves a backup copy to the working directory whenever 
you open a file. The backup file retains the original file name with a .bak 
extension appended to it.

The encryption tool interface has an icon bar with the following icons. 

Icon Description

The file open icon opens a file browser, allowing you to select the 
unencrypted template you want to encrypt. 

The !crypt_start icon activates an insertion cursor. Clicking the left 
mouse button in the text window then inserts the !crypt_start and 
pack 002 lines at the cursor location. 

This icon is only enabled if the template has no start and end lines or 
there are complete start and end line pairs.

The !crypt_end icon activates an insertion cursor. Clicking the left 
mouse button in the text window then inserts the !crypt_end line at 
the cursor location.

This icon is only enabled after a !crypt_start line has been inserted.

The encrypt icon invokes the ai_encryp utility and encrypts the 
portions of the template wrapped in the !crypt_start and !crypt_end 
lines.

This icon is only enabled if the template has both the start and end 
lines inserted.

The undo and redo icons provide multiple undo and redo of the 
!crypt_start and !crypt_end insertions.
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Encrypting Templates
To encrypt a template using the Encryption tool:

1. From the Model Architect tools menu, select Encryption Tool.

The small help window at the bottom of the tool interface provides hints to 
guide you.

2. If you do not want to save a backup of the original template file, from the Edit 
menu, select Tool Preferences and uncheck Save Backup. The tool will 
remember your preference on future invocations.

3. Click the File Open icon or from the File menu, select Open. 

You see the contents of the template file in the text editor portion of the tool. 

If the file does not appear to be a valid MAST template or the file appears to 
be already encrypted, you see an error message. 

If the template is valid and is not already encrypted, the encrypted keyword 
is inserted, if it is needed.

4. Click the green !crypt_start button to activate the !crypt_start insertion 
cursor. 

5. Use the left mouse button to select the position for the start of the 
encryption. 

Typically the encryption start point is below the template header so that the 
end user can still read the template arguments and connection points.

The !crypt_start and 002 lines are inserted and the red !crypt_end button 
becomes enabled.

6. Click the red !crypt_end button to activate the !crypt_end insertion cursor. 

7. Use the left mouse button to select the position for the end of the encryption. 
The text insertion cursor must be placed prior to the final closing brace of 
the template.

8. Repeat steps 4–7 for each section of the template you want to encrypt.

Do not nest the start/end pairs. This means that after a !crypt_start line you 
must have a !crypt_end line before the next !crypt_start line. If you make a 
mistake use the undo and redo buttons.

9. Click on the encrypt icon to run the encryption utility. 
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This icon will only be enabled if all of the start and end points are in proper 
alignment. If you open a template that is already prepared for encryption this 
icon will be enabled immediately.

After performing the encryption, the tool window displays your encrypted file. 

10. Inspect the file to ensure that the encryption was carried out as expected 
prior to distributing the template.

Thermal Impedance Tool Enhancements (STAR 9000003211)

In the Y-2006.06-SP2 release, the Thermal Impedance tool includes the 
following enhancements:
■ The thermal RC stages can vary from 2 to 7. With this enhancement, you 

can decide how many RC stages you need to match the thermal impedance 
characteristics. For irregular curves with more than three inflection points, 
you may see better results if you use more stages. The default number of 
stages is 3.

■ New Rth anchor line. In the previous version, when you dragged the Rth 
anchor line, the tool kept the ratio of Rth (Cauer form) unchanged and 
changed the poles of the RC network accordingly. The result was that the 
shape of the thermal impedance curve changed. In Y-2006.06-SP2, the Rth 
anchor line keeps the ratio of Rth (Foster form) and the poles of the network 
unchanged and instead, changes each Cth appropriately. With this 
enhancement, you can adjust the sum of Rth while keeping all the poles 
unchanged. From a graph perspective, when you drag the Rsum anchor 
widget, the thermal impedance curve moves up and down while the shape 
remains the same.

■ New pole anchor lines. There is a new pole anchor line widget. It allows you 
to adjust each individual inflection point (pole) while keeping Rsum and all 
other poles unchanged. With these two new anchor widgets, you can quickly 
get very good initial values of R and C for the optimizer. 

■ The optimizer now optimizes on the equivalent Foster topology of the 
original Cauer topology, so the values of R and C in the optimizer window 
are different than those in the main window. In the main window, the values 
of R and C are for the Cauer topology. In the optimizer window, the values 
of R and C are for the Foster topology.
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Battery Tool Enhancements (STAR 9000142958)

The battery tool has been improved for the Y-2006.06-SP2 release. The 
changes include:
■ Support scanned data input. The Battery tool now supports all three 

formats: ai_dat, ai_scan and ai_pl.
■ For ai_pl input, a pull-down list of the signals in the plot file is provided to 

make it easier for you to select the corresponding signals.
■ For ai_dat file input, the defined format is displayed so that you can fix the 

input file if there is an error detected.
■ An entry field was added allowing you to specify the name of a file that 

contains the load current waveform for transient discharge and charge 
characteristics. If a current waveform file is specified, the contents of the file 
overrides the data point entries. The current waveform file and voltage 
waveform file must have the same file extension.

■ At the dc spec step, optimization on self discharge characteristics is now 
optional. By default, there will be no optimization on self discharge 
characteristics. The optimization will be carried out only when you have the 
target data and select to do so.

■ The behavior of the Next button has been improved. At any step, clicking the 
Next button will go to the next required step. Some steps may be skipped to 
make it more convenient for you to step through the characterization flow. 
However, you can always go to any step by selecting the step from the 
characterization flow pane (the left pane).

■ A new battery model, batt_pb_2th, has been added to the supported model 
list. Now you can create a lead acid battery model with a thermal pin.

Updates to Co-Simulations, Frameway Integrations and 
Interfaces

The Y-2006.06-SP2 release has updates to the following co-simulations and 
Frameway integrations:
■ SaberHDL Simulink Co-simulation Interface
■ Saber Simulink Co-Simulation Interface
■ SaberLink/Matlab Frameway
■ Simulink-2-Saber Model Export Utility
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■ Saber/Verilog Co-Simulation Interface
■ Mentor Graphics ePD Frameway

SaberHDL Simulink Co-simulation Interface
SaberHDL Simulink co-simulation has been added in the Y-2006.06-SP2 
release. Its usage is similar to that of Saber Simulink co-simulation. 

To support co-simulation with both Saber and SaberHDL simulators 
simultaneously, we replaced the original simulink_cosim_sync.dll with 
simulink_cosim_sync_saber.dll and simulink_cosim_sync_saberhdl.dll. 

After you install Y-2006.06-SP2 and the saberhdl 2006.06.2.183 add-on, you 
can find the dlls under the following directories:

Install_root/Saber/bin/simulink_cosim_sync_saber.dll

Install_root/SaberHDL/bin/simulink_cosim_sync_saberhdl.dll

If you are using an earlier version than Matlab R14 SP3, you need to copy the 
correct co-simulation libraries and rename them. The Simulink co-simulation 
files are located in the following directories:

Install_root/Saber/bin/Matlab_version

Install_root/SaberHDL/bin/Matlab_version

Matlab includes two major sub products: Matlab engine and Simulink engine. 
The following table shows the most recent versions of the Matlab products. 

For example, if you are using Matlab R14, you need to copy the SaberHDL 
co-simulation library simulink_cosim_sync_saberhdl7.0.dll and the Simulink 
libraries from SaberHDL/bin/Matlab_7.0 to SaberHDL/bin and rename the 
co-simulation library to simulink_cosim_sync_saberhdl.dll. If you want to use 
Saber Simulink co-simulation, copy the Saber co-simulation library 
simulink_cosim_sync_saber7.0.dll and the Simulink libraries from 
Saber/bin/Matlab_7.0 to Saber/bin and rename the co-simulation library to 
simulink_cosim_sync_saber.dll.

Saber Simulink Co-Simulation Interface
The Saber Simulink Co-Simulation now supports Matlab versions 2006a and 
2006b. The default version remains R14 SP3.

Matlab version Matlab engine version Simulink engine version

R14 SP3 7.1 6.3

R14 7.0 6.0
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SaberLink/Matlab Frameway
The Saber Simulink Co-Simulation now supports Matlab versions 2006a and 
2006b. The default version remains R14 SP3.

Simulink-2-Saber Model Export Utility
The Simulink-2-Saber Model Export utility has been tested successfully against 
MATLAB releases 14 SP3, 2006a and 2006b. Use the latest version of the 
utility available at:

install_root/Y-2006.06-SP2/Saber/lib/tool_model/Simulink2SaberRTWexport_
Matlab7_1

If you are using the Model Export utility with the 2006b MATLAB release, the 
Mathworks-specific Real-Time Workshop (RTW) may generate an error after 
the process successfully completes. The error is benign and RTW-specific.

Saber/Verilog Co-Simulation Interface
The Saber/Verilog co-simulation has been updated in the Y-2006.06-SP2 
release to support LDV 5.6 on Solaris, HP8000, HP9000 and Linux.

Mentor Graphics ePD Frameway 
The Mentor Graphics ePD Frameway integration has been updated in the 
Y-2006.06-SP2 release to support ePD 2005 on Windows.

New Models

This release has the following new models: 
■ Idealized Brake Models
■ Idealized Continuously Variable Transmission Model (CVT)
■ Multiple Inputs Time Domain System Analyzer Model
■ Linear Variable Differential Transformer with Two Secondary Coils Model

Idealized Brake Models
The brake template models an ideal friction brake (disc and drum types) with a 
mechanical translational position port as input and a mechanical rotational 
velocity port as output. 
19

New Features, Enhancements, and Changes in Y-2006.06-SP2



Synopsys Release Notes
Saber Version Y-2006.06-SP2 
The model is based on the mechanical principle to calculate the braking torque 
from the actuating force and the energy conservation principle to estimate the 
disc/drum temperature rise from the environmental temperature. 

The brake types from which you can chose are: 
■ Disc brake
■ Duo-servo drum brake
■ Duo-duplex drum brake
■ Simplex drum brake

The major features modeled are: 
■ The braking torque varies with the actuating force
■ The braking torque varies with the vehicle speed
■ The braking torque varies with the disc/drum temperature

Idealized Continuously Variable Transmission Model (CVT)
The cvt_w template models a continuously variable transmission. The model is 
ideal in the sense that the efficiency is 100%. The model has two angular 
velocity ports for the input and output shafts and an input control port to control 
the gear (pulley) ratio. 

Multiple Inputs Time Domain System Analyzer Model 
The new tdsa2 template is a two-input, time domain system analyzer. It is very 
much like the original tdsa model. The main difference is that the gain and 
phase are now calculated as the ratio of the measure input and the reference 
input. The original model calculated gain and phase as a ratio of the input to 
the output. This allows the model to be applied in a manner similar to a 
'Venable' loop gain measurement device or an HP dynamic signal analyzer.

Linear Variable Differential Transformer with Two Secondary 
Coils Model
The new lvdt3 template is a linear variable differential transformer with two 
secondary coils. It is very much like the original lvdt model. The main difference 
is that lvdt3 has two secondary coils. When the core moves from side to side, 
the voltage amplitude of one secondary coil increases while that of the other 
coil decreases. When the coils are in the middle position, both output voltages 
are the same. It results in the total output being zero if they are connected in 
opposition.
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New Component Models

The Y-2006.06-SP2 release contains the following component models:
■ maxx_65n—Everstart brand 90 Ah lead-acid battery manufactured by JCI
■ maxx_75n—Everstart brand 55 Ah lead-acid battery manufactured by JCI
■ cs3361x—Alternator regulator model with thermal pin 
■ irf640x—Dynamic thermal HEXFET power MOSFET

The Dynamic thermal power MOS is available with the new Dynamic 
Thermal Alternator design example.

Dynamic Thermal Alternator with Charging System Loads and 
Battery Example (STAR 9000132326)

The Y-2006.06-SP2 release includes a 1.4KW, 3-Phase, 12-Pole 14.45VDC 
Dynamic Thermal Alternator with Charging System Loads and Battery 
example. This example is a typical application of a dynamic thermal automotive 
alternator configured as an air-cooled machine, implemented in a simple 
charging test system.

To view the new example, from the Saber Sketch or Saber Harness Tools menu 
or the Tool bar, select Design Examples.

Saber Quick Start Enhancements

The Saber Quick Start documentation has been updated to more accurately 
reflect the current functionality in Saber. Tool screenshots have been updated 
and new screenshots added to enhance the usability of the document.

Resolved STARs in Y-2006.06-SP2

The Synopsys Technical Action Requests (STARs) listed in the following table 
are resolved in version Y-2006.06-SP2. 

Table 3 Resolved Saber STARs 

STAR ID Title

9000147735 Auto ref in Saber Bundle MCad import corrupts consintency with Saber 
Harness

9000144968 Template opening problem in Part Gallery
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Auto ref in Saber Bundle MCad import corrupts consintency 
with Saber Harness (STAR 9000147735)

When importing data using the Catia V5 interface, all of the element refs were 
renamed using the auto ref function. Only elements of type junction, passive 
and segment should be renamed. 

This problem has been fixed in Y-2006.06-SP2. 

9000141620 Error in StateAMS model - basically, the tool auto picks the wrong type of 
unit

9000141270 Printing result of dotted line are solid and light

9000141220 Import MCAD wire lengths does not work for MCAD 1.1 files

9000141201 Add Raise/Lower to RMB when over a physical wire

9000139665 Saber Harness wire labels disappear when components are connected, 
moved

9000138825 CVC performance multiple sheets open

9000137773 Re-Reference crashes Saber Sketch

9000137753 We can not see all connector categories

9000135133 Cannot annotate schematic if a probe is placed

9000134533 Saber DIA may fail on IBM because of file name

9000130655 Design Architect Frameway creates script with wrong permissions on 
Windows

9000125996 Impossible to create subharness with the same name as an assembly

9000114181 Rename of assemblies doesn't show in Passive Property Editor

9000099647 Find/select shows all components on a sheet

9000099645 Filter takes components which have the default variant value :*opt*

9000095176 Saber saves in temporary files

9000086707 display error message open design

9000086702 Issue release crashes during simultaneous release to same release folder

9000074189 assembly data lost when harness is closed

9000053733 Wrong results in Find/Select

TKS0070033 Part_no & desc. of earth symbol not transmitted from schematic to bundle

Table 3 Resolved Saber STARs (Continued)

STAR ID Title
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Template opening problem in Part Gallery (STAR 9000144968)

In the 2006.06-SP1 release, the Parts Gallery View Template menu command 
resulted in the application hanging.

This problem has been fixed in Y-2006.06-SP2. 

Error in StateAMS model - basically, the tool auto picks the 
wrong type of unit (STAR 9000141620) 

The declaration of thermal and rotational quantities in the StateAMS modeling 
tool was resulting, under certain conditions, in a MAST syntax error. 

This problem has been fixed in Y-2006.06-SP2. 

Printing result of dotted line are solid and light 
(STAR 9000141270)

In large Sketch or Harness schematics, thin dashed lines appeared solid when 
they were printed. 

This problem has been fixed in Y-2006.06-SP2. 

Import MCAD wire lengths does not work for MCAD 1.1 files 
(STAR 9000141220)

When an MCAD version 1.1 file was imported in Saber Harness, the import 
process aborted and issued an error. 

This problem has been fixed in Y-2006.06-SP2. 

Add Raise/Lower to RMB when over a physical wire 
(STAR 9000141201)

In Saber Harness, the Back/Front operation was only supported from the 
Schematic menu. 

In Y-2006.06-SP2, Back/Front have been added to the right mouse button 
popup menu when you are on a wire.
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Saber Harness wire labels disappear when components are 
connected, moved (STAR 9000139665) 

The physical wire definition properties disappeared after moving a connected 
symbol. The definition properties reappeared by moving the mouse over the 
physical wire. 

This problem has been fixed in Y-2006.06-SP2. 

CVC performance multiple sheets open (STAR 9000138825)

CVC performance was poor when the changes were made to one or two 
sheets while other sheets were open, even when there were no changes made 
to the other sheets.

For each of the opened sheets, when the sheet was being re-opened after a 
check in operation, some files were read multiple times.

This problem has been fixed in Y-2006.06-SP2. 

Re-Reference crashes Saber Sketch (STAR 9000137773)

A Re-Ref symbol reference would cause Saber Sketch to crash if there was a 
connector in the schematic.

This problem has been fixed in Y-2006.06-SP2.

We can not see all connector categories (STAR 9000137753)

Two problems have been fixed with the visibility preferences of the top level 
categories in Parts Gallery:
■ The visibility preferences of the top level categories relied on an indexing 

scheme to refer to a particular category. When the list of top level categories 
was modified (a category added or deleted), the indexing was not updated 
resulting in some categories being visible when they should not and vice 
versa.

■ Visibility preferences of top level categories were applied when the Parts 
Gallery was invoked in Harness from the Property Editor to select 
connectors, cables, bundles, etc, using the same indexing scheme. These 
preferences should not have been applied because the visibility preferences 
were set for the main Parts Gallery.
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These two problems have been addressed in Y-2006.06-SP2 by changing the 
way the visibility preferences are saved. Because of this change, you need to 
reset the visibility of the Parts Gallery top level categories. 

Cannot annotate schematic if a probe is placed 
(STAR 9000135133)

In Saber Sketch, if the Draw tool window was within the probe area, you could 
not annotate any item.

This problem has been fixed in Y-2006.06-SP2.

Saber DIA may fail on IBM because of file name 
(STAR 9000134533)

Individual runs of Saber distributed iterative analysis (DIA) may fail because 
they can't find intermediate files. The message "Cannot open the file 
<design_name>.<number>_environment.wf" was displayed.  The problem was 
that the actual file had a slightly different name, e.g. missing one letter. The 
resulting plotfile had empty segments for the runs that failed. 

This problem has been fixed in Y-2006.06-SP2.

Design Architect Frameway creates script with wrong 
permissions on Windows (STAR 9000130655)

Starting Saber applications from Mentor Graphics' Design Architect could fail 
on Windows due to permission problems.  

This problem has been corrected in Y-2006.06-SP2 by directly starting the 
sock_opt program instead of creating and executing a local command file.

Impossible to create subharness with the same name as an 
assembly (STAR 9000125996)

In Saber Harness, you could not create a subharness with the same name of 
an assembly if the assembly was created first. However, after you created the 
subharness, you could change the name to match the name of the assembly.

This problem has been fixed in Y-2006.06-SP2. 
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Rename of assemblies doesn't show in Passive Property Editor 
(STAR 9000114181)

If a user renamed an assembly in the Saber Harness Assembly tool, this 
change didn't show in the assembly field in the Passive Property editor. Only 
the assembly database was getting updated when an assembly was renamed. 

This problem has been fixed in Y-2006.06-SP2. All the necessary databases 
are updated.

Find/select shows all components on a sheet 
(STAR 9000099647)

In Saber Harness, the Find operation incorrectly handled the name of the 
sheet.

In Y-2006.06-SP2, only the symbols whose names match the pattern entered 
by the user will be found with settings "All sheets" and "Symbol".

Filter takes components which have the default variant value 
:*opt* (STAR 9000099645)

In prior releases, objects that had no variant assignment or that used the *opt* 
variant were automatically assumed to be common elements and were used in 
the Assembly Tool. In Y-2006.06-SP2, the behavior of the Assembly Tool filter 
has changed from matching anything to matching nothing. As a result, all 
common elements need to have a property that indicates they are common or 
the Assembly Tool will filter them out and not use them.

This change is the result of changes to the design rule checks to make them 
more deterministic. Before this change, it was not possible to determine 
whether *opt* was empty because the object was common or because it was 
accidently left empty. 

Changes to the filter will at a minimum affect the following features:
■ Export from Harness to Bundle
■ Bundle tool
■ Export DSI
■ Any place where data needs to be extracted with filters
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Saber saves in temporary files (STAR 9000095176)

The root cause of this problem was that in Saber Harness data was saved into 
a temporary file before checking whether the data could be saved to the 
database. 

In Y-2006.06-SP2, when you do not have write permission for the directory in 
which the design is open or for the database files to be changed, the save 
operation will be denied and there will no longer be any temporary files on the 
file system.

display error message open design (STAR 9000086707)

The parser in the Saber Harness Assembly Tool that read the assembly data 
accepted a line of at most 1023 characters long. The length of the attribute field 
in the assembly database may go beyond that limitation. 

In Y-2006.06-SP2, the parser has been modified to accept lines of more than 
1023 characters. 

Issue release crashes during simultaneous release to same 
release folder (STAR 9000086702)

Saber Harness was not able to detect that Issue Release was done in the issue 
directory shared with multiple users instead of the individual directory specified 
by the release name under the shared issue directory. Additionally, the lock 
mechanism was not set correctly to handle the possibility of users performing 
Issue Release concurrently.

In Y-2006.06-SP2, you can use Issue Release with a different release name 
under the shared issue directory.

assembly data lost when harness is closed (STAR 9000074189)

If the Assembly Tool was invoked before a design was opened, the data in the 
Assembly Tool was not refreshed. 

This problem has been fixed in Y-2006.06-SP2. 
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Wrong results in Find/Select (STAR 9000053733)

In Saber Harness, when you searched in the variant-field, the results showed 
data from the ref-field.

The root cause was that the Find operation added the ref name as a part of the 
target text to match when searching a property field. This problem has been 
fixed in Y-2006.06-SP2. 

Part_no & desc. of earth symbol not transmitted from 
schematic to bundle (TKS0070033)

Previously, in some specific cases, some properties were not updated from 
Harness to Bundle, such as part_no. 

This problem has been fixed in Y-2006.06-SP2. 
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Saber® Release Notes for Version Y-2006.06-SP1

This document is protected by copyright.

These release notes present the latest information about Saber Version 
Y-2006.06-SP2 in the following sections:
■ New Features, Enhancements, and Changes in Y-2006.06-SP1
■ Resolved STARs in Y-2006.06-SP1

New Features, Enhancements, and Changes in Y-2006.06-SP1

Version Y-2006.06-SP2 provides new features, enhancements, and changes as 
described in the following sections:
■ Clean Files Feature
■ Style Sheet Default Symbol Color (STAR 9000121279)
■ New Models
■ New Component Models
■ Design File Changes in Y-2006.06

Clean Files Feature

The Saber Clean Files feature enables you to delete non-essential files that are 
created during a Saber simulation session, such as netlister state files, 
cross-probing support files, Saber initial point files, data files, table files, 
iterative analysis files and application log files. These files are not design 
source files that you’ve created and used as input to a simulation, such as 
schematic and model files. 

Using Clean Files You can access the Clean Files feature from Saber 
Sketch, Saber Harness and Saber Guide.

To clean files:

1. From the File menu, select Clean Files or from the operating system 
command line, enter saberclean.
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The Saber Clean window opens in the current working directory showing a 
list of selected files to delete. 

2. If necessary, change the directory. To change the directory, type the 
directory in the directory field or navigate to the directory in the Directories 
pane.

When you change directories, the Matching Files pane updates to show the 
files that match the active file types. For more information, see Managing 
File Types.

3. To change the list of selected files, do any of the following:

• Click on a file name to select or unselect it.

• Click on the file type to select or unselect all the files of that type.

• Click on the file type folder to close the folder and unselect all the files 
in the folder.

4. Click OK to delete the selected files.

Managing File Types You can manage the file types used in Saber Clean by 
changing the options in the Preferences tab. Here you can activate or 

Directory 
entry field

Directory 
pane

File type
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deactivate file types, add new file types, change file types and remove file 
types.

To manage file types:

1. From the File menu, select Clean Files or from the operating system 
command line, enter saberclean.

2. In the Saber Clean window, click the Preferences tab. 

3. Do any of the following:

• To activate a type, check the box next to the file type.

• To deactivate a type, uncheck the box next to the file type.

• To add a file type, click the Add button. Enter a description and file 
extension.

Deactivated 
file type

Activated file 
type

Custom file 
type
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• To change a file type, double-click on the file type. Change the 
description or the file extension. 

• To remove a file type, select the file type and click the Delete button. You 
can only remove user-added file types. 

4. Click Save to save your preferences to .saberclean_user. 

Note: You can apply the saved preferences to all users by copying the 
.saberclean_user file to sabercleanRc.site and moving the file to the 
location specified by the AI_SITE_PATH environment variable.

Style Sheet Default Symbol Color (STAR 9000121279)

The default color for symbols now comes from the style definition. 

In the Y-2006.06 release, the default color for a symbol came from the symbol 
definition. For more information on Style Sheets, see “Style Sheets” on 
page 49.

New Models

In this release, there are the following new models: 
■ Dynamic Thermal Alternator Model (STAR 9000129374)
■ Ideal Solenoid Model (STAR 9000129310)
■ Idealized Encoder Models
■ Nonlinear Temperature Sensor Model (STAR 9000126911)
■ Var/nu Actuated Clutch Model

Dynamic Thermal Alternator Model (STAR 9000129374)
There are two thermal alternator models in this release: masstherm_w and 
alternator_corex. 

masstherm_w The masstherm_w template models a thermal element with 
consideration for thermal resistance and heat capacitance. The easily 
configured thermal resistance changes non-linearly as a function of rotational 
speed. This permits usage in applications where thermal resistance of an 
element changes due to windage (e.g. cooling) that is usually a function of 
rotational velocity of external devices such as fans. The masstherm_w template 
offers flexibility as may be applied in either heating or cooling applications.
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alternator_corex The alternator_corex template models a self-heating 
3-phase, wye-connected, symmetrical electro-mechanical generator. As a 
physical behavioral model it embraces electrical, magnetic, mechanical, and 
thermal characteristics of a typical salient or cylindrical synchronous machine. 
It may be implemented as the representation of an automotive alternator in 
typical charging system scenarios or as a synchronous turbo generator for high 
power systems. 

This model includes the effects of temperature sensitive magnetic saturation. 
This implies the internal flux couplings are a function of shaft rotational angle 
and magnetic flux densities and permeabilities of saturable rotor and stator 
core permeances/reluctances. Incorporation of 3rd harmonic in the output 
phase voltage is a function of machine saliency. The model also offers 
self-excitation effect caused by magnetic remanence. It includes dissipative 
losses such as copper losses, core losses, running friction, windage, and 
inertia associated with a typical alternator machine. Rectification of the 3-phase 
output and field current control are external to this template.

The objective of this model is to provide realistic transient behavior with 
inclusion of physical ripple and harmonics. This allows accurate assessment of 
an alternator machine versus AC rectification, and permits investigation of 
power boost and efficiency schemes. Investigation of what-if scenarios can 
also be performed due to resonant loads, load dump and transient suppression 
protection, detailed field current regulator implementations, and more accurate 
failure analyses (e.g. shorted or open diodes, field winding short). 

Because power generation devices, such as an alternator, are fundamental to 
the integrity of the power distribution system, examination of the system 
performance cannot be carried out with much certainty if these devices are too 
ideal. For example, models capable of providing ample current under operating 
conditions when physical devices cannot. The goal of more detailed alternator 
device models are to target and investigate specific phenomenon that impact 
the system, as opposed to the system performance over an entire drive cycle.

Ideal Solenoid Model (STAR 9000129310)
The sw_solenoid template models an ideal solenoid electrical switch. When the 
coil of the solenoid is driven by a current with sufficient strength, the magnetic 
field will be strong enough to pull the plunger. When the displacement of the 
plunger is equal to the specified stroke, an electrical switch is closed to allow 
electrical current to flow through the armature.

Thermal effect is not modeled.
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Idealized Encoder Models
There are two encoder models in this release: r_encoder and r_encoder_p/pw.

r_encoder The rencoder (rencoder_w) template models an ideal absolute 
type rotary encoder with a mechanical rotational port as input and a state 
variable as output. 

The input to the rencoder template is the rotational angle port and the input to 
the rencoder_w template is the rotational velocity port. The state variable 
output will have n possible distinct integer values ranging from 0 to n-1, where n 
is the number of distinct positions on a 2p circle specified as a model 
parameter. 

The output can be converted to an analog signal by connecting to a z2v model. 
If necessary, the analog signal can be further converted to a physical signal by 
connecting to a var2x model, for example, var2v for voltage.

r_encoder_p/r_encoder_pw The rencoder_p (rencoder_pw) template 
models an ideal relative type rotary encoder with a mechanical rotational port 
as input and a digital pulse signal as output. 

The input to the rencoder_p template is rotational angle port, and the input to 
the rencoder_pw template is rotational velocity port. The digital output will have 
n pulses per revolution, where n is the number of teeth on a 2p circle specified 
as a model parameter. 

The output can be converted to a digital counter to determine the relative 
position of the shaft.

Nonlinear Temperature Sensor Model (STAR 9000126911)
The tempc2var_lu template models a non-linear temperature sensor with time 
delay. The template has two thermal_c ports for inputs and an output control 
port for an output.

The Table Look Up modeling Tool (TLU) is used to specify the relationship 
between the input differential and the output. There are two instances of TLU 
used by this template. The first one defines the sensor’s output value as a 
function of the temperature difference between the two inputs. The other 
defines a time constant (tau) as a function of the input differential.

The output can be converted to an analog signal by connecting to a z2v model. 
If necessary, the analog signal can be further converted to a physical signal by 
connecting to a var2x model, for example, var2v for voltage.
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Var/nu Actuated Clutch Model
The template clutch_vctrl is a model of a friction clutch actuated by a 
control signal. The friction in the contact between the driving and the driven 
shaft is controlled by a control signal applied to the cntrl port. The friction 
torque is simulated as a function of relative velocity and assumed to be the sum 
of the Stribeck, Coulomb (dry), and viscous terms. The transition from the 
breakaway to the Coulomb friction is assumed to be exponential. No dynamic 
friction terms are considered in the template.

New Component Models

This release includes the TJA1020 LIN Transceiver component.

Design File Changes in Y-2006.06

In the Y-2006.06 release, the design file was upgraded to version 10. This 
affected Saber Harness, Saber Bundle and Saber Sketch. For more 
information, see “Design File Upgrade to Version 10” on page 47. 

Note: There are no additional design file changes in Y-2006.06-SP1.

As a result of the changes to the data files in the Y-2006.06 release, they are no 
longer backward compatible. You cannot open a Y-2006.06 design file in a 
previous release. However, you can save a Y-2006.06 design file using an 
earlier design format. 

To save the design using a previous design format:

1. With the design open, from the File menu, select Save As.

2. In the Files of Type list, select an earlier version from the list.

3. Click Save.

Resolved STARs in Y-2006.06-SP1

The Synopsys Technical Action Requests (STARs) listed in the following table 
are resolved in version Y-2006.06-SP1. 

Table 4 Resolved Saber STARs 

STAR ID Title

9000130853 Simulink-2-Saber Model Export makefile that generates MAST model 
cleanup req
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Simulink-2-Saber Model Export makefile that generates MAST 
model cleanup req (STAR 9000130853)

The Simulink-2-Saber Model Export utility, particularly the portion that 
generated the MAST model wrapper for the RTW compiled c-code (that 
represented the Simulink model), incorrectly made a MAST model that 
contained a foreign routine call in the parameter section, passing signal values, 
which essentially had no values at that time. The parameter section call 
(mode 1) performed some message reporting, some error checking, and data 

9000130410 Memory consumption explodes for TLU models with large dataset

9000129450 CatiaV5 V5 MCad projection bugs

9000129239 Error message when opening sub-schematic

9000127273 Calclength table function using decimals in length property not working

9000127046 Logical wires are invisible after move/zoom operation

9000126736 Mcad import corrupted in Saber Bundle

9000124274 simulink model import

9000123074 testify result will change after I clear previous result and run again

9000122287 Data disappeared during checkout

9000122157 Saber monte carlo fails on Linux

9000114201 Adding same shell twice

9000114182 It is not possible to filter for the complete Instrument harness

9000111000 unchanged pasted commands do not appear in the command history

9000108024 Filter does not clear in table manager

9000108023 After run APS - no assemblies from Assembly Tool

9000105983 The APS result includes only the first connector that has been marked

9000099670 Extract and update on assembly table does not increase number of rows

9000096604 Cannot open acroread 7.0 on Linux from Saber

9000094535 Problem Opening Symbol and Schematic w/ same name at same time

9000082291 No Monochrome Print option on Windows.

9000081771 Optimizer of diode tool I-V characteristic does not change I-V parameters

9000072282 documentation c_friction is missing

9000002558 line style changes with zoom level

TKS0053589 Ratings properties on 'op1' symbol do not match SaberBook

Table 4 Resolved Saber STARs (Continued)

STAR ID Title
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file log initialization, however the placement of signal names was incorrect, as 
this did not load and run in SaberHDL. 

This problem has been fixed in Y-2006.06-SP1. 

Memory consumption explodes for TLU models with large 
dataset (STAR 9000130410)

A memory leak has been fixed in the tlu foreign routine in Y-2006.06-SP1. This 
memory leak was causing an expansion of the Saber process memory during 
Monte Carlo analyses involving large data file table look-up (tlu) models.

CatiaV5 MCad projection bugs (STAR 9000129450)

In Saber Bundle, there were error messages when placing segments or 
passives on a Bundle drawing. 

Sometimes an error occurred when the “Show Unmatched Items” on the Filters 
Control Panel was set to Show and an MCAD file was imported to update an 
existing bundle drawing. 

Sometimes an error occurred when placing passives to update an existing 
bundle drawing from an MCAD import that contained significant differences 
from the existing design. 

These problems have been fixed in Y-2006.06-SP1.

Error message when opening sub-schematic 
(STAR 9000129239)

If the CVS directory resided in the design or symbol directory, when the design 
or symbol was opened in Saber Sketch, there was a CVC error .

This has been fixed in Y-2006.06-SP1. 

Calclength table function using decimals in length property not 
working (STAR 9000127273)

In Saber Harness, when using decimal values on the property length on Bundle 
segments, the lengths were not calculated correctly. 

This has been fixed in Y-2006.06-SP1.
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Logical wires are invisible after move/zoom operation 
(STAR 9000127046)

In Saber Harness, if you converted a logical wire to a physical or vice versa, the 
wire became invisible after doing a zoom operation. 

This has been fixed in Y-2006.06-SP1.

Mcad import corrupted in Saber Bundle (STAR 9000126736)

When importing an MCad file generated with Catia V4 E3D the ref property for 
the E3D connector shells is not put in the shell ref in Saber Bundle. The ref 
from Catia is put in the mcad_id property. 

The problem occurred because importing an older MCAD 1.0 format into Saber 
Bundle was not done correctly. The value of the ref property in the bundle 
drawing was suppose to be set to the name of the corresponding ref in the 
imported MCAD 1.0 file. 

This problem has been fixed in Y-2006.06-SP1. The ref property in Saber 
Bundle drawing elements is now being set correctly after importing an MCAD 
1.0 file.

simulink model import (STAR 9000124274)

The Simulink-2-Saber Model Export Utility has been updated to work with 
Saber 2006.06 release. The Export Utility provided with the Y-2006.06-SP1 
release is required to build Saber models that will work the Y-2006.06 release. 
Saber models produced by this release are not backward compatible with 
earlier Saber releases. Nor will Saber models built using the Export Utility in 
earlier versions of Saber work in the Y-2006.06 and future releases.

testify result will change after I clear previous result and run 
again (STAR 9000123074)

The plotfile on disk currently uses a timestamp with a granularity of one 
second. Testify simulations can occur at a faster rate than can be shown on the 
plotfile’s timestamp. The problem manifests itself if the simulations defined in 
the Testify experiments take less than 1 second. As a result, Guide may use an 
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older version of the plotfile stored in memory, rather than reloading the plotfile 
from disk into memory. 

This problem has been fixed in Y-2006.06-SP1.

Data disappeared during checkout (STAR 9000122287) 

The problem was that the error handling in CVC was incomplete. The “obtained 
lock” information returned by CVS was interpreted incorrectly as an error 
message. In turn, the CVC operation was interrupted. In the user's case, the 
CVC Checkin operation was not finished, so the correct data could not be 
returned when checked out.

This problem has been fixed in Y-2006.06-SP1.

Saber monte carlo fails on Linux (STAR 9000122157)

Saber Monte Carlo and Vary runs fail on Linux because files are not closed 
properly. Because the files are left open, the Saber process eventually reaches 
the resource limit for open files and the analyses fail. This problem can also 
happen when using distributed processing (DIA) for Monte Carlo and Vary 
runs. 

This problem occurs only on the Linux platform. It is fixed in Y-2006.06-SP1.

Adding same shell twice (STAR 9000114201) 

In Saber Bundle, if the “To Place” list had more than ten items and they were all 
marked, when you pressed Apply, they all were placed on the bundle sheet. But 
the list still showed some shells and if they were marked they were placed a 
second time. 

This problem has been fixed in Y-2006.06-SP1. Now when you click the Apply 
button, there items placed are cleared from the list.

It is not possible to filter for the complete Instrument harness 
(STAR 9000114182) 

The problem was that the component shell filter operation on a big design took 
so long that the user felt the operation did not work.
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This problem has been fixed in Y-2006.06-SP1. The performance of the 
existing component shell filter has been improved so that the filter operation on 
a big design can be completed in an acceptable time interval.

unchanged pasted commands do not appear in the command 
history (STAR 9000111000)

When a multi-line command was pasted into the command window, all of the 
commands executed but did not appear in the command history.

This problem has been fixed in Y-2006.06-SP1.

Filter does not clear in table manager (STAR 9000108024) 

The filters shown in the Table Tool did not correspond to the filter actually used 
in the following cases:
■ The filters for harness, subharness/assembly were not shown after “Extract 

Data.”
■ The filters for “Entire Design” were not shown initially when the Table Tool 

was invoked for the first time.

This problem has been fixed in Y-2006.06-SP1.

After run APS - no assemblies from Assembly Tool 
(STAR 9000108023) 

When you ran the APS on one connector, you couldn’t get into the Assembly 
Tool from the Connector Manager -Passive Property Editor field. Before 
running APS, you could go into the Assembly Tool and choose assemblies. 
After running APS, it is not possible on any connector

This problem has been fixed in Y-2006.06-SP1.

The APS result includes only the first connector that has been 
marked (STAR 9000105983) 

The root cause was that the information about the selected shells was not 
processed correctly when there were more than one component shells 
40

Resolved STARs in Y-2006.06-SP1



Synopsys Release Notes
Saber Version Y-2006.06-SP2
selected. This resulted in passing only the first marked shell to the APS 
module.

The APS module in Y-2006.06-SP1 now receives information about all the 
selected component shells.

Extract and update on assembly table does not increase 
number of rows (STAR 9000099670) 

When extracting and updating a table, the rows of the table did not update 
according to the table contents. Therefore, some rows could be missing. 

This has been fixed in Y-2006.06-SP1. The table now updates correctly.

Cannot open acroread 7.0 on Linux from Saber 
(STAR 9000096604)

Saber failed to open acroread 7.0 on the Linux platform when opening Saber 
documents. This has been fixed in Y-2006.06-SP1.

Problem Opening Symbol and Schematic w/ same name at 
same time (STAR 9000094535)

A design could not be opened when a symbol with the same name was opened 
first. 

This problem has been fixed in Y-2006.06-SP1.

No Monochrome Print option on Windows. (STAR 9000082291)

The default print color on the Windows platform was color. This has been set to 
monochrome in the Y-2006.06-SP1 release.

Optimizer of diode tool I-V characteristic does not change I-V 
parameters (STAR 9000081771)

The functionality of the Model Architect Diode Characterization Tool optimizer 
has been improved in the Y-2006.06-SP1 release. Additional fields have been 
added to the optimization target form which allow you to specify an x-axis data 
range for optimization.
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documentation c_friction is missing (STAR 9000072282)

Added the template description for the c_friction model in the Y-2006.06-SP1 
release.

line style changes with zoom level (STAR 9000002558) 

During the zoom in operation in Saber Sketch, some of the graphics items that 
were using dashed outline lines were changing to a solid outline. This is fixed in 
the Y-2006.06-SP1 release. 

Similar behavior also existed if you changed the dash outline width. This is also 
fixed in the Y-2006.06-SP1 release.

Ratings properties on 'op1' symbol do not match SaberBook 
(TKS0053589)

The ratings properties have been updated in the template descriptions for op1, 
op3, and op3d models for the Y-2006.06-SP1 release. 

The ratings properties for op1h and opfd1were fixed in a previous release.
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Saber® Release Notes for Version Y-2006.06

This document is protected by copyright.

These release notes present the latest information about Saber Version 
Y-2006.06 in the following sections:
■ Supported Environments
■ New Features, Enhancements, and Changes in Y-2006.06
■ Known Problems and Limitations in Y-2006.06
■ Resolved STARs in Y-2006.06

For convenience, these release notes also contain the CosmosScope release 
notes in the following sections:
■ CosmosScope Release Notes for Version Y-2006.06
■ CosmosScope Release Notes for Version X-2006.03

Supported Environments 

This release of Saber is compatible with the platforms and operating systems 
shown in Table 5. 

Table 5 Supported Platforms

Platform Operating System

SUN (Sparc OS5) 32-bit Solaris 9 with Shared Library patch 111711-12 or later

Solaris 10

HP9000 with PA-RISC 2.0 
(HP 8000), 32-bit 

HP-UX 11.0 and 11.11 (11i)

PC/Windows, IA-32 (X86), 32-bit Windows 2000 with Service Pack 3 or higher

Windows XP Professional 

PC/Linux, IA-32 (X86), 32-bit 

PC/Linux, AMD Opteron, 64-bit

Red Hat Enterprise 3.0 with Update 5

Red Hat Enterprise 4.0

IBM RS6000, 32-bit AIX 5.3
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Table 6 shows the supported platforms and programming languages. 

Note: To use the saberld command on IBM RS/6000 AIX, the C++ compiler 
specified in Table 6 must be installed and accessible on your system.

Table 7 shows the supported products for co-simulators, frameway integrations, 
and interfaces. 

Table 6 Platforms and Programming Languages 

Platform C C++ Fortran

SUN Solaris (Sparc) 5.5 (Sun Studio 8) 5.5 (Sun Studio 8) 7.1 (Sun Studio 8)

HP9000 PA-RISC 2.0 (HP 
8000) using HP-UX 11

B.11.11.04 A.03.33 B.11.01.42

PC/Windows MS Visual .NET MS Visual .NET Intel Visual Fortran 
9.0 with patch 24

PC/ Red Hat Linux gcc 3.3.6 g++ 3.3.6 g77 3.3.6

IBM RS6000 AIX VisualAge 6.0 VisualAge 6.0 xlfcmp 8.1.1.4

Table 7 Product Matrix for Co-Simulators, Frameway Integrations and Interfaces 

OS

Product

Solaris 2.8 HP 8000 Windows Linux IBM RS6000

Co-Simulator Interfaces

Saber/Verilog 
Co-Sim

LDV 5.1 
LDV 5.5 
(Cadence IC 
V5.1) 

LDV 5.1 
LDV 5.5 
(Cadence IC 
V5.1) 

— LDV 5.5 
(Cadence IC 
V5.1)

Note: RHEL 
3.0, 4.0

—

ModelSim Co-Sim 6.0d 6.0d 6.0d — —

VCS/VCS-MX 
Co-Sim

7.2, 
2005.06-SP1

Note: Solaris 
9 only

7.2, 
2005.06-SP1

— 2005.06-SP1

Note: Red 
Hat 
Enterprise 
3.0 only

—

Simulink Co-Sim — — 6.1, 6.5, 7.0, 
7.0 SP1, 
7.0 SP2, 
7.0 SP3

— —
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Frameway Integrations

Mentor Graphics 
Falcon Framework

EN2002 with 
CDP SP3, 
EN2004, 
IC2002.3
IC2004.3

EN2002 with 
CDP SP3, 
EN2004, 
IC2002.3
IC2004.3

EN2002 with 
CDP SP3, 
EN2004

2005.1

Note: Red 
Hat 
Enterprise 
3.0 and AMD 
architecture 
only

—

Mentor Graphics 
ePD

— — ePD 2004 — —

Cadence (3.5) IC 5.1 IC 5.1 — IC 5.1 —

EDIF (3.4) Berkeley 
EDIF 2.0

Berkeley 
EDIF 2.0

— Berkeley 
EDIF 2.0

—

SaberLink/
MATLAB

5.2, 5.3, 6.1, 
6.5, 7.0 
7.0 SP1, 
7.0 SP2, 
7.0 SP3

5.2, 5.3, 6.1, 
6.5

5.2, 5.3, 6.1, 
6.5, 7.0 
7.0 SP1, 
7.0 SP2, 
7.0 SP3

6.1, 6.5 —

Saber Harness Interfaces

ProE 2001 2001 2001 — —

CATIA V5 R14 R15, 
R16

V5 R14 R15, 
R16

V5 R14 R15, 
R16

— —

Unigraphics — — NX3 — —

Table 7 Product Matrix for Co-Simulators, Frameway Integrations and Interfaces 

OS

Product

Solaris 2.8 HP 8000 Windows Linux IBM RS6000
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New Features, Enhancements, and Changes in Y-2006.06

Saber Version Y-2006.06 provides new features, enhancements, and changes 
as described in the following sections:
■ Design File Upgrade to Version 10
■ Style Sheets
■ Multi-level Undo and Redo
■ Design Example Browser
■ Auto-generated Symbols
■ Improved Saber Harness CVC Performance
■ Association Behavior When Moving Passive Elements (STAR 9000109174)
■ Saber/Catia Interface Support (STAR 9000087970)
■ Catia Interface Passive Insertion Enhancements
■ Assembly Table Columns Switched (STAR 9000105980)
■ DIA Enhancements
■ VDA Library
■ Unigraphics to Saber Harness Translator (UG2SH) (STAR 9000042002)
■ New Models
■ New Component Models
■ Battery Characterization Tool (STAR 9000116842)
■ IGBT Characterization Tool
■ New Fortran Compiler for Windows
■ Saber Simulator AC Analysis Supports the Creation of an End Point File 

(STAR 9000084788)
■ Saber Simulator Pole/Zero Report Supports Hz (STAR 9000084937)
■ Using Acrobat Reader with the Saber Y-2006.06 Release
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Design File Upgrade to Version 10 

In the Y-2006.06 release, the design file has been upgraded to version 10. This 
affects Saber Harness, Saber Bundle and Saber Sketch. The changes in 
version 10 include the following:
■ Added style resource.
■ Each element in the database has a new field for its assigned style.

All Saber Harness designs created in a previous release must be upgraded to 
the latest version using the following procedures before working on them in this 
release. For additional information, see the following sections:
■ Upgrading Saber Harness Design Files Not Using CVC
■ Upgrading Saber Harness Design Files Using CVC

For Saber Sketch and Saber Bundle designs, the upgrade happens 
automatically.

Upgrading Saber Harness Design Files Not Using CVC
The following procedure must be completed for each Saber Harness design 
you want to use in the Y-2006.06 release.

To upgrade Saber Harness design files that do not use CVC:

1. Create a new directory for the Y-2006.06 version of the design.

2. Open the design in the Y-2006.06 release.

3. From the File menu, select Save As.

4. In the Save As dialog box, navigate to the new directory and click Save.

You can now continue working in the design.

Upgrading Saber Harness Design Files Using CVC
The following procedure must be completed for each Saber Harness design 
you want to use in the Y-2006.06 release.

To upgrade Saber Harness design files that use CVC, administrators must do 
the following:

1. Have users check in their workspaces using the previous release.
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2. To ensure that the workspace includes all of the files associated with the 
design, in the previous release of Saber Harness, do one of the following:

• Open the design in an existing workspace and from the Schematic 
menu, select Version Control > Update. 

• Create a new workspace and open the design in the workspace.

Do not use CVC to check out the design.

3. Exit Saber Harness.

4. Create a new directory for the Y-2006.06 version of the design.

5. Rename the Workspace’s CVS directory. 

The CVS directory is located in the Workspace directory. Later, you can 
remove the renamed CVS directory once you are sure that the design has 
been upgraded correctly and you no longer need the directory.

6. Rename the design’s repository. 

Later, you can remove this repository once you are sure that the design has 
been upgraded correctly and you no longer need the repository.

7. Using the Y-2006.06 Saber Harness release, save the design to the new 
directory created in step 4. Do the following:

a. Open the design in the workspace. 

Do not use CVC to check out the design.

b. From the File menu, select Save As.

c. In the Save As dialog box, navigate to the new directory created in 
step 4 and click Save.

d. Close the design.

8. Using the Y-2006.06 release, store the design in the repository. Do the 
following:

a. Open the design saved in the new directory in Saber Harness.

Do not use CVC to check out the design.

b. From the Schematic menu, select Version Control > Store Design.

c. Close the design.

9. Have users create their workspace for the design stored in Y-2006.06.

You can now continue working in the design.
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Style Sheets 

The Y-2006.06 release provides you with the option to change the background 
and component colors in the Saber Sketch and Saber Harness editors. For 
more information on style sheets, see the Saber Sketch User Guide.

Saber now provides pre-defined style sheets:
■ Color on Black Background (default)
■ Color on White Background
■ Black on White Background

A style sheet is composed of styles. Each style includes three elements: text 
style, line style, and fill style. In this release, you can only change the color 
attribute of these elements.

The Saber style sheets use a similar model as style sheets in text editing tools. 
When you create a new, custom style sheet, you copy it from an existing style 
sheet. The base style sheet colors are used until you add or change a style in 
the custom style sheet. You can override a style in a style sheet by changing 
the object’s color attribute.

When you open a schematic or symbol, the active style sheet is applied to the 
drawing. If the drawing has a style that is not in the active style sheet, the new 
style is added to the all of the style sheets.

You can select a variety of objects in your schematic and assign them to a 
common style. For example, you can select a wire, originally assigned to the 
Logical Wire style, and a rectangle, originally assigned to the Graphics style, and 
assign it to a your custom Electrical style. 

You can preview your drawing as it will look when you print or export the 
drawing. Previewing your drawing does not change the color of the objects in 
the database.

Color Behavior in Pre-Y-2006.06 Drawings
Pre-Y-2006.06 schematics or symbols will use the default style sheet, Color on 
Black Background, or whatever you’ve set for the active style sheet. 

Objects in your drawings will automatically show colors based on the object 
type. For example, a logical wire will show the Logical Wire style color. 

Objects in your pre-Y-2006.06 drawings that use the default colors will use the 
colors defined in the styles of the active style sheet. For example, if you have a 
graphical text object that used the default Pink, then when you open the 
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drawing in this release with the default style sheet, Color on Black Background, 
the text will still show Pink. If you change the active style sheet to Color on 
White Background, the text will change to Blue. 

Object that do not use the pre-Y-2006.06 default colors keep their original 
colors. The custom color is treated as an override to the style. For example, if 
you changed the color of a graphical text object to Green, then when you open 
the drawing in this release with the default style sheet, Color on Black 
Background, the text will show Green. If you change the active style sheet to 
Color on White Background, the text will remain Green because it overrides the 
style. To use the style color, you must reapply the style to the object. 

Multi-level Undo and Redo

Saber Sketch now supports multi-level undo and redo for all operations. Saber 
Harness supports the multi-level undo and redo for operations available in 
Saber Sketch.

Design Example Browser

With the Y-2006.06 release, there is now an easy way to access design 
examples from Saber Harness and Saber Sketch. 

To open the Design Browser:

■ From the Tools menu or the icon bar, select Design Examples.

The upper half of the Design Example Browser shows a hierarchical list of 
design examples organized by application. 

The lower half of the Design Example Browser shows a brief description of the 
selected example.

You can do the following tasks in the Design Example Browser:
■ To expand or collapse a folder hierarchy, click on the Plus or Minus icon next 

to a folder.
■ To select an example and show its description, click on an example icon or 

the example text.
■ To install an example, double-click on the example icon or example text. 

Follow the installation instructions to install the example.
■ To view the full documentation for the selected example, click the Help 

button.
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In the Y-2006.06 release, there are four new power converter examples and 
one vehicle networking example:
■ 3ph AC/DC Converter with Brushless DCPM load 
■ 3ph 230V AC to 28V DC Converter
■ 288V to 14V DC/DC Converter
■ 3ph 230V AC -> 3ph 115V AC/AC Converter
■ LIN Bus

Auto-generated Symbols

In this release, you can automatically generate Saber Sketch symbols from 
MAST model files, VHDL-AMS model files and hierarchical schematics. 
Although in previous releases Saber Sketch opened the symbol editor and 
added ports when you requested a symbol for a hierarchical schematic, and 
Saber Sketch obtained property information from a new MAST model, this 
release brings together all these elements and adds some key enhancements. 
You can now use VHDL-AMS models to create symbols and you’ll see 
improvements to symbol generation from hierarchical schematics. You can 
easily modify the generated symbol using the new Symbol Editor Assistant.

When you request a symbol for a model file or a schematic, the generated 
symbol opens in the Symbol Editor Assistant and the Symbol Editor. In the 
Symbol Editor Assistant, you can easily move ports, rotate the symbol, flip the 
symbol, change property visibility and save the symbol. Changes you make in 
the Symbol Editor Assistant immediately show in the Symbol Editor.

Improved Saber Harness CVC Performance 

With this version of Saber Harness, support has been added to use the server 
features of CVS. In order to provide reliability and security, we only support the 
client-server protocols of CVS with the CVSNT product from March-Hare Pty 
Ltd. 

Only the :local: protocol is supported for the CVS that is shipped with Saber 
Harness. Only the :sspi: protocol on Windows is supported for the CVSNT that 
you can get from March-Hare PTY Ltd. Other protocols may work, but they 
have not been tested. Use them at your own risk.

For optimum performance, use the following configurations:
■ Locate all site database files on a local area network (LAN) server.
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■ Locate each user’s workspace on the user’s local computer.
■ Locate the repository on either a LAN server or a wide area network (WAN) 

server. Use the appropriate version of CVS for the repository location. See 
below.

To improve performance, use one of the following CVS versions:
■ GNU CVS 1.12.13

Use this version if your repository is located on a LAN server. This is an 
updated version from the previously provided GNU CVS 1.10.6. For more 
information, see the following section, “Using GNU CVS 1.12.13” on 
page 53. 

■ CVSNT 2.5.02

Use this version if your repository is located on a WAN server. This is a new 
version of CVS that you can download. For more information, see “Using 
CVSNT 2.5.02” on page 53.

Note: Some experts recommend that repositories on LAN or WAN servers 
should always be accessed using a client-server protocol to maximize 
reliability. With a robustly configured network environment, we have found 
the :local: protocol sufficient for LAN systems. If you are concerned about 
the reliability of your network environment, then you should consider using 
CVSNT for your LAN configuration as well.

New environment variables
The following environment variables were added to configure CVS and CVSNT. 
For more information on setting these variables, see “Using GNU CVS 1.12.13” 
and “Using CVSNT 2.5.02” on page 53. 

AI_CVS

Defines the path to the CVSNT executable used by Saber Harness. You do 
not typically need to set this environment variable if you want to use the CVS 
executable shipped with Saber Harness. However, if you have another CVS 
executable in your path, then define this environment variable to point to the 
CVS executable shipped with Saber Harness.

AI_CVS_ARGS

Specifies additional global arguments for the CVS command. With CVSNT, 
it is recommended that you use –z9.
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AI_USE_CVSNT

Indicates to Saber Harness that you are using CVSNT instead of GNU CVS. 
This is an important indicator because CVSNT requires special handling.

AI_CVSROOT

Specifies the –d argument value for CVS. If this is not set, then it defaults to 
:local:$env(AI_VCROOT).

For CVSNT, use 
:sspi:network_user_id@server_hostname:Respository_Alias. 

Note: Set up your CVSNT configuration so that passwords are not required. If 
you require passwords, they are stored in workspace files. For more 
information, see the CVSNT documentation.

Using GNU CVS 1.12.13
To use CVS 1.12.13:

1. If necessary, unset the following environment variables:

AI_CVS
AI_CVS_ARGS
AI_USE_CVSNT

2. Set AI_VCROOT to the directory that contains the repository as seen on the 
local system.

3. Set AI_CVSROOT to :local:$env(AI_VCROOT).

Using CVSNT 2.5.02
Before you begin, ensure that all users log in to the same domain.

To use CVSNT 2.5.02:

1. The following are tasks that the Administrator must complete:

a. Purchase and download CVSNT 2.5.02 from www.cvsnt.org.

b. Install CVSNT 2.5.02 on the server where the repository is or will be 
located.

The repository must be a local disk on the same machine that is running 
the server.

c. Specify a local directory as the repository (for example, c:/Repository).
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d. Use CVSNT 2.5.02 to register the repository on the server with the alias, 
“/RepositoryAlias.” For information on registering the repository, see the 
CVSNT documentation.

e. Share the repository directory, allowing all users read and write 
permissions.

2. The following are tasks that must be completed for each user:

a. Install the CVSNT 2.5.02 client.

b. Map the shared repository directory on the server to a local drive. For 
example, h:/RepositoryMount.

Note: You must have at least one directory in the path. Do not map the 
drive to the root folder, such as z:\.

c. Set the following system variables in the start script:

set env(AI_USE_CVSNT) 1
set env(AI_VCROOT) “repositoryMount”
set env(AI_CVSROOT) 

“:sspi:netwk_user_id@server_hostname:alias_name”
set env(AI_CVS) “cvsNT_2.5.02_install_path”
set env(AI_CVS_ARGS) –z9

where:

• repositoryMount is the mapped local drive of the registered 
repository (for example, h:/RepositoryMount)

• netwk_user_id is the user’s network login ID on the domain (for 
example, fred)

• server_hostname is the name of the server hosting the repository 
(for example, barney)

• alias_name is the name of the alias defined on the CVSNT server 
(for example, /RepositoryAlias)

• CVSNT_2.5.02_install_path is the path to the CVSNT 2.5.02 
executable (for example, c:/Program Files/CVS 
Suite/CVSNT/cvs.exe)
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For example, using the previous information, the environment variables 
in the start script are as follows:

set env(AI_USE_CVSNT) 1
set env(AI_VCROOT) “h:/RepositoryMount”
set env(AI_CVSROOT) 

“:sspi:fred@barney:/RepositoryAlias”
set env(AI_CVS)

“c:/Program Files/CVS Suite/CVSNT/cvs.exe”
set env(AI_CVS_ARGS) –z9

Association Behavior When Moving Passive Elements 
(STAR 9000109174)

In previous releases of Saber Harness, when you moved passive elements in 
bundle drawings, the element would re-associate when placed over a bundle 
segment. This caused unexpected behavior, rearranging elements and 
re-associating passive elements exchanged using the parts browser.

With this release, the behavior has changed to the following:
■ If you move a passive element with the mouse and it is already associated 

with a bundle segment, then the association will not change regardless of 
where you place the passive. 

■ If you move a passive element with the mouse and it is not associated with 
a bundle segment, then it will be associated with the bundle segment over 
which you place it. 

■ If you move a passive element with the mouse and the ALT key, then the 
passive element will be associated with any bundle segment over which you 
place it, even if it was previously associated with a bundle segment. 

Saber/Catia Interface Support (STAR 9000087970)

The Saber Harness/Catia V5 interface has been updated to support Catia V5 
R16. 

Catia V5 R15 and R14 continue to be supported.
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Catia Interface Passive Insertion Enhancements

The Catia V5 R16 interface has been enhanced to allow the following actions:
■ Placing BSJs at Splice and Passive Points
■ Enhanced Properties for Traceability
■ Importing Protection Passives
■ Replacing Imported Passive Elements

The MCAD file format has been modified to enable these enhancements. 
MCAD files have been updated from version 1.0 to version 1.1. 

Note:
These features are not supported in the Saber Harness/Catia V5 R15 or the 
Saber Harness/Catia V5 R14 interfaces.

Placing BSJs at Splice and Passive Points
In the Y-2006.06-2 release, you now have the option to place bundle segment 
junctions (BSJs) at all splice and passive locations that are not already at BSJ 
points. Placing BSJs at these locations splits the bundle segment, creating new 
bundle segments. The new bundle segments and BSJs are uniquely named. 

This is a preference you can set before you import the Catia MCAD file into 
Saber Harness or Saber Bundle.

To place BSJs at splice and passive points on import:

1. From Site Manager, in the Preference Settings, click Bundle Import/Export 
Preferences.

Note: In previous releases, this was the Bundle Export Preferences button.

2. In the Bundle Import/Export Preference dialog box, shown below, check 
Apply BSJs to Passive Offset Points.
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Figure 7 Bundle Import/Export Preference Dialog Box 

Enhanced Properties for Traceability
When you import a Catia MCAD file into Saber Harness or Saber Bundle, 
passives, bundle segments and bundle segment junctions (BSJs) now have the 
following properties: 

If the reference designator is not set in Catia, Saber Harness and Saber Bundle 
automatically generate a reference designator value. 

Importing Protection Passives
Saber Harness and Saber Bundle now correctly import protection-type 
passives that cover more than one bundle segment. Each protection that spans 
more than one bundle segment is a shared symbol.

Replacing Imported Passive Elements
When you replace a passive element imported from an MCAD file with a part 
selected from the Parts Gallery, you now have the option to keep the original 
instance properties or remove them.

The Parts Gallery has been enhanced to allow replacement of shared symbols. 
When you replace a shared symbol, only select one symbol. All the symbols 

Saber Property Value

part_no Catia reference part number

mcad_id Catia instance name

ref Catia reference designator
57

New Features, Enhancements, and Changes in Y-2006.06



Synopsys Release Notes
Saber Version Y-2006.06-SP2 
will be replaced. If the shared symbols are instantiated on multiple sheets that 
you don’t have checked out, you’ll be prompted to check out them out. 

Updating Elements
When you import an MCAD file, you have the ability to show the elements that 
need updating. You can update the elements in two ways:
■ Remove any items that were placed in the bundle drawing from a previous 

MCAD import that are no longer present in the current MCAD file. 
■ Ensure that all items are placed in the drawing, the properties for these 

items are correctly updated from the MCAD file and any required 
associations are built correctly. 

To remove items that are no longer present in the current MCAD file:

1. Import the MCAD file. 

2. Open MCAD Projection. 

3. On the MCAD toolbar, click the Show/Hide button. 

This opens the Filters Control Panel.

4. In the Filters Control Panel, for Unmatched Items, click the Show button. 

This selects all of the items in the bundle drawing which are no longer present 
in the MCAD file. 

5. To delete the selected items, use the Delete key or the Delete menu item.

To ensure items are placed, properties updated and associations built:

1. If necessary, delete all the unmatched Items, as previously described. 

2. In the Filters Control Panel, select the corresponding Show Needs Update 
button. 

This shows only those items in the bundle drawing that need to have their 
properties updated. 

3. To update the properties and also to make sure that the correct associations 
are built (for passives and splices only), select the corresponding Place and 
Update icon on the MCAD toolbar. 

This does the following: 

• Ensures the element is placed
58

New Features, Enhancements, and Changes in Y-2006.06



Synopsys Release Notes
Saber Version Y-2006.06-SP2
• Updates the property values for the placed element

• Ensures associations for splices and passives are set properly

Assembly Table Columns Switched (STAR 9000105980)

In Saber Harness, the position of the Description and Issue columns in the 
Assembly table have been switched.

DIA Enhancements 

An improvement has been made to enhance the performance of the Saber 
distributed iterative analysis feature. The improvement reduces the time 
required to combine the results of individual distributed runs into a single 
results plot file.

VDA Library 

The VDA library has been added to the list of supported standard packages. 

Unigraphics to Saber Harness Translator (UG2SH) 
(STAR 9000042002) 

The UG2SH plug-in to Unigraphics has been updated to work with Unigraphics 
NX3 and Unigraphics TeamCenter. This plug-in is linked against the NX3 
libraries and has only been tested to work with NX3. It works with the Saber 
Harness W-2004.06, X-2005.09 and Y-2006.06 releases.

The format for the ai_mcad file has been modified to be consistent with 
X-2005.09 and later splices. This does not cause any compatibility problems, 
because the W-2004.06 release does not support splices during import of the 
ai_mcad file.

In addition, part names in NX3 have changed to include the base part name 
and extended information. For example, an NX2 part 94367303 is represented 

Library Standard Content

spice2vhd VDA all

fundamentals_vda VDA all except q_trpf_vda.vhd
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in NX3 as 94367303.geo_fin003.001999. To be consistent with part_no used in 
Saber Harness, only the base part name (for example, 94367303) is used.

To install the UG2SH plug-in, run setup.exe on a machine with NX3 loaded. 
This installs and configures the environment with the new UG2SH plug-in. In 
the installation directory the ugnx and ugnx2 directories still exist and contain 
the plug-ins from previous versions. These previous plug-ins are no longer 
supported.

New Models

In this release, there are the following new models: 
■ Torque Converter Model
■ DC_PM2x Model
■ Alternator Models

Torque Converter Model
The torque converter model enables you, in conjunction with an engine model 
and a transmission model, to simulate the drive train system. 

There are two variations of this model:
■ Template tqc_r is a model of a torque converter with rotational angle-type 

terminals.
■ Template tqc_w is a model of a torque converter with rotational velocity-type 

terminals.

The model is a high-level behavioral model based on table look-up, no friction, 
damping and inertia. It can be simulated by connecting related models at the 
impeller or turbine of the torque converter. 

This model has the following three modes: 
■ Normal behavior. This behavior is determined by two curves that you 

provide: one is torque ratio vs. speed ratio between the turbine and the 
impeller and the other is the capacity factor vs. rotational speed ratio 
between the turbine and the impeller. In this mode, the turbine always runs 
slower than the impeller, the efficiency is less than 1, and the output torque 
is greater than the input torque. 

■ External lockup mode. In the external lockup mode, the turbine is locked 
up with the impeller in a one-way direction when there is a lockup signal. The 
clutch is an ideal clutch without transition time. A fixed 1m second is used 
between the transition from lock and unlock to make the model continuous. 
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The turbine cannot run slower than the impeller, but it can run faster. In most 
cases, the turbine speed is the same as the impeller speed. The torque can 
only flow in one direction through the impeller to the turbine. 

■ Internal lockup mode. In the internal lockup mode, the turbine is locked up 
with the impeller automatically in a one-way direction when the turbine 
speed exceeds the impeller speed. The difference between this mode and 
the external lockup mode is that the torque converter will be locked 
automatically when the turbine speed exceeds the impeller speed. 

DC_PM2x Model
This is a variant of the existing DCPM model. The dc_pm2x model enables you 
to do thermal transient analysis of a DCPM motor by counting on the motor 
loss. These losses give rise to heat generation within the motor. As the motor 
temperature increases, the armature resistance, torque constant, and back 
EMF parameters change in a way that increases the total power loss and 
degrades motor performance. If a constant torque output is maintained, the 
motor may reach a thermal runaway condition, exceed the maximum winding 
temperature, and burn out. Although there are other parameters that affect 
temperature, like dynamic friction and the viscous damping, their effect on 
motor performance is less unless in high-speed motors. These dependencies 
are not modeled.

The dc_pm2x template models a permanent magnet dc machine that may act 
as either a motor or generator, depending on how it is connected. 

Alternator Models
There a two new alternator models and two component models in this release:
■ Alternator Model
■ Alternator Regulator Model
■ Alternator Regulator Component Model
■ Alternator Diode Bridge Component Model

Alternator Model

The alternator_core template models a 3-phase, wye-connected, symmetrical 
electro-mechanical generator. As a physical behavioral model it embraces 
electrical, magnetic, mechanical, and thermal characteristics of a typical salient 
or cylindrical synchronous machine. 
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You can implement it as a representation of an automotive alternator in typical 
charging system scenarios or as a synchronous turbo generator for high power 
systems. 

This model includes the effects of temperature sensitive magnetic saturation. 
This implies the internal flux couplings are a function of shaft rotational angle 
and magnetic flux densities and permeabilities of saturable rotor and stator 
core permeances/reluctances. Incorporation of 3rd harmonic in the output 
phase voltage is a function of machine saliency. 

The model also offers self-excitation effect caused by magnetic remanence. It 
includes dissipative losses such as copper losses, core losses, running friction, 
windage, and inertia associated with a typical alternator machine. Rectification 
of the 3-phase output and field current control are external to this template.

The objective of this model is to provide realistic transient behavior with 
inclusion of physical ripple and harmonics. This allows accurate assessment of 
an alternator machine versus AC rectification, and permits investigation of 
power boost and efficiency schemes. Investigation of what-if scenarios can 
also be performed due to resonant loads, load dump and transient suppression 
protection, detailed field current regulator implementations, and more accurate 
failure analyses (e.g. shorted or open diodes, field winding short). Because 
power generation devices, such as an alternator, are fundamental to the 
integrity of the power distribution system, examination of the system 
performance cannot be carried out with much certainty if these devices are too 
ideal, for example, capable of providing ample current under operating 
conditions when physical devices cannot. The goal of more detailed alternator 
device models are to target and investigate specific phenomenon that impact 
the system, as opposed to the system performance over an entire drive cycle.

Alternator Regulator Model

The alt_gen template is a high-level model representation of an alternator 
regulator. Its default characterization is based upon a manufactured 
after-market alternator regulator device still in production. The model offers 
constant frequency with variable duty cycle operation, proportional gain with 
gain saturation and lag element (mimics a real regulator), and an internal 
free-wheeling diode. It offers the convenience of simple circuit application with 
minimal characterization, and flexibility of voltage bus implementation - no 
restrictions on system battery voltage (i.e. 12V or 36V)
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Alternator Regulator Component Model

A new component level alternator regulator template of the cs3361 regulator is 
also available. Features of this component model are:
■ Temperature compensated regulation voltage
■ Short circuit field protection duty cycle, self clearing
■ Stator power up
■ Lamp pin to indicate abnormal operating conditions
■ Constant frequency with variable duty cycle operation
■ Senses ignition start, stopped engine or broken belt condition, under and 

over-voltage detect
■ Drives logic-level power NFET
■ Resumes “normal” operation once fault condition ceases
■ Use with 12-Volt battery systems only

Alternator Diode Bridge Component Model

This component level lr1120701_bridge template models the 3-phase full-wave 
diode bridge rectifier implemented in a Hitachi alternator, OEM part number 
lr1120701. 

The diodes within the rectifier assembly were measured in Synopsys' device 
laboratory and determined to be 50-Amp Zener (avalanche) diodes with 21.5V 
breakdown voltage. The breakdown for these diodes is rated at 100mA reverse 
current. This template is fully static thermal, and stress ratings for each diode 
component were determined by measurement.

New Component Models

This release has the following component models:
■ AD8139 low noise rail-to-rail differential ADC driver
■ AD8608 low noise opamp
■ AD976ABR 16-bit A/D converter
■ ADCMP552 high speed PECL/LVPECL comparator
■ Alternator regulator 
■ Alternator diode bridge
■ Fairchild ES2d power diode
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■ L6561 power factor corrector
■ LT6200 low noise opamp
■ Maxim 4494 opamp
■ Phillips BUK765r2_40b n-channel power FET
■ Phillips BUK9640 n-channel power FET
■ Phillips BYV32EB rectifier diode
■ Renesas 2SK1317 1500V n-channel power diode

Battery Characterization Tool (STAR 9000116842)

A characterization tool for the new lead acid battery model batt_pb_2 has 
been developed and is in beta release.

This new tool accepts specifications on a lead acid battery and generates a 
component battery model that meets the specifications within acceptable 
tolerance.

Instructions are provided for each characterization step. This tool is capable of 
characterizing a battery automatically. Four characteristics, including self 
discharge, constant current discharge, transient discharge and transient charge 
characteristics, are automatically characterized, one after another, to best meet 
the customer's specifications.

Upon completion, a component battery model will be generated for use in 
system design.

To access the Battery tool:

1. Start Saber Sketch or Saber Harness.

2. From the Tools menu, select Model Architect.

3. In the Model Architect window, click the Battery tool icon.

IGBT Characterization Tool

This release includes the IGBT characterization tool. The IGBT 
characterization tool and model are a simplification of the Hefner IGBT model 
developed by Dr. Hefner of the National Institute of Standards and Technology in 
cooperation with Synopsys. 

You can use the IGBT characterization tool to create IGBT models. The Saber 
model library provides an intermediate and proven level-1 IGBT model 
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(igbt1_2.sin) that is easier and more practical to characterize than the Hefner 
model. To aid in making the characterization process easier for this new model, 
it was put into the IGBT characterization tool, a dedicated Model Architect tool.

The IGBT characterization tool implements the parameter extraction for the 
new IGBT model in a step-by-step process to enable you to more easily create 
component models. You must supply a set of characteristic device data that you 
can obtain from a variety of sources. 

To access the IBGT tool:

1. Start Saber Sketch or Saber Harness.

2. From the Tools menu, select Model Architect.

3. In the Model Architect window, click the IGBT tool icon.

New Fortran Compiler for Windows

Saber uses a different and more recent version of Fortran compiler on the 
Windows platform. As a result, foreign routines for the Saber and SaberHDL 
simulators written in the C language can no longer use __stdcall. 

To use these routines in this release, remove __stdcall from any foreign 
routines, recompile and link into a new DLL. DLLs created for previous releases 
will not work with this or future releases of Saber.

Saber Simulator AC Analysis Supports the Creation of an End 
Point File (STAR 9000084788)

The AC analysis now supports the creation of an end point file. This file 
contains an estimate of the large signal steady state of the design at the end 
frequency of the AC analysis. The estimate is exact for linear systems. 

The large signal steady state estimate may be useful to start the simulation of a 
switched system close to the actual steady state, for example without having to 
go through all the startup transients. To do this, run an AC analysis with an end 
frequency that corresponds to the switching frequency, then use the resulting 
AC end point file as an initial point file for a TR analysis.
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Saber Simulator Pole/Zero Report Supports Hz 
(STAR 9000084937)

The Saber Simulator pz_report command (Pole/Zero Report) now supports 
displaying frequency data in Hz. To do this, specify the unit to be Hz. The 
default unit is radians/second (radps). 

Additionally, the pz_report command now supports sorting poles and zeros 
based on a key, which must be REAL, IMAG, or one of the values specified for 
the pz_report command with the ptranslist or ztranslist variables (in Guide, 
the Columns for Poles or Columns for Zeros). Sorting may be useful, for 
example, to quickly find the pole with the largest or smallest pole frequency.

Using Acrobat Reader with the Saber Y-2006.06 Release

Viewing PDFs in Acrobat Reader
If you are using a version of Acrobat Reader that is older than version 7, you 
may see the following message:

This file may contain newer information than this viewer can support. It may 
not open or display correctly. Adobe recommends that you upgrade to the 
latest version of our Acrobat products. 

The Saber Y-2006.06 documentation does not use any special features and 
should display correctly. However, we do recommend that you upgrade to the 
latest version of Acrobat Reader.

Searching the Documentation for Information
A full-text search index is available to help you find information by rapidly 
searching all Saber manuals at once.

To use the full-text search feature:
■ Adobe Reader must be invoked as a standalone application rather than as 

a plug-in to your web browser.
■ Solaris and Linux platforms must have Adobe Reader 7 installed. 
■ Windows platforms must have Adobe Reader 6 or Adobe Reader 7.

If your system does not meet these criteria, you can still initiate keyword 
searches with previous versions of Adobe Reader.
66

New Features, Enhancements, and Changes in Y-2006.06



Synopsys Release Notes
Saber Version Y-2006.06-SP2
Adding and Using a Full-Text Search Index with Adobe Reader 7 

If a Saber full-text search index is not available, you might need to add it 
manually.

To add a and use a full-text search index, 

1. Open Acrobat Reader 7 with any Saber PDF.

2. Choose Edit > Search or click the Search button in the toolbar. 

The Search PDF pane shows on the right-hand side of the screen.

3. At the bottom of the Search panel, click Use Advanced Search Options.

4. At the top of the Search panel, enter the word or phrase for which you want 
to search.

5. From the Look In list, choose Select Index.

The Index Selection dialog box appears.

6. If you see Synopsys Saber, Y-2006.06 in the Select Index window, skip to 
step 10. Otherwise, continue to the next step.

7. Click Add.

8. In the Open Index File dialog box, navigate to the location where your Saber 
documentation resides.

Typically the documentation is in the 
/<install_location>/doc/pdf_docs directory.

9. Double-click index.pdx.

The Saber Y-2006.06 index is added to the list of available indexes.

If there is more than one index in the list, uncheck the other indexes. If they 
remain checked, the documents associated with the index will also be 
searched.

10. Check the Saber Y-2006.06 index and click OK.

The next time you choose Search, Acrobat will remember the Saber 
Y-2006.06 search index, index.pdx, as a location to search. 

11. Click Search.

The results appear in order of relevance in the Results pane. To change the 
order, select another option from the “Sort by” list.

Click an item in the results list.

For more information about the search capability, see the Acrobat or Acrobat 
Reader online help.
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Known Problems and Limitations in Y-2006.06

This section describes known problems, limitations, and workarounds in Saber 
Version Y-2006.06.

Can’t Load Design in Guide from Frameways 
(STAR 9000118978)

For Cadence and Mentor Graphics ePD frameways, when you start a 
stand-alone Guide or Guide with Scope from Saber > Start Saber Guide or 
Saber > Start Saber Guide with Scope menus, the design does not load in 
Saber even if a valid netlist is present. 

You see the following message:

“Cannot find design /test/…/design_name”.

You might also see this problem in the Mentor Graphics Falcon Framework 
frameway.

Scripts that make a call to Guide:LoadDesign will fail if you give a full path to 
Guide:LoadDesign instead of just the design name. For example, the 
following will fail:

Guide:LoadDesign /u/mytest/design_name.sin 

On the other hand, the following will succeed in starting Guide:

cd /u/mytest
Guide:LoadDesign design_name.sin

Workaround 
Manually load the design.
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Resolved STARs in Y-2006.06

The Synopsys Technical Action Requests (STARs) listed in the following table 
are resolved in Saber Version Y-2006.06.

Table 8 Resolved Saber STARs 

STAR ID Title

TKS0079614 Paste into/from Saber and Windows Clipboard fails

TKS0050410

TKS0040095

TKS0059694

TKS0065287

Response times very high

Saber take a long time to update the repository

Opening sheets after a required update is very slow

Very long response times and timeouts at checkin of bundle

9000114021 Can't save Experiment if already saved in previous invocation.

9000113564 Get stack trace when adding information on connector passives

9000112939 Obtain errors about repository's lock

9000112126 Saber Bundle crashes switching 2 designs

9000112073 Crash when using close active design

9000109882 Drag & drop to different sheets with different components gives the same 
component from the “NEW” Parts gallery

9000109174 regroup problem when moving object

9000109161 Problem with emag_coil_tlu.sin

9000106857 CVS lock doesn’t disappear

9000103093
9000101101

Guide with Scope crashes in 2004.12 release.
Saber crashes every 10 minutes

9000100181 StateAMS: the condition ((a>b)|(a>c))&(b>c) leads to an error message

9000099675 When a new workspace is created the missing symbols window appears

9000096125 Testify: cannot save tests/experiments

9000095187 Saber Bundle crashes in non CVC behavior

9000094578 Data disappears from pass.prop.editor

9000093494 Import data from SDU does not show OK/Cancel & spaces in directory path 
fails

9000093200 Predefined tests are lost, the experiment is not filled in.

9000091910 Assembly tool corrupt when renaming assembly

9000090209 The Catia reference part number shall be the part number in Saber.

9000089860 chassis model: duplicate reference name

9000088845 Checked in values of .ai_hrndsn file was lost in second check-in

9000088610 wirep model: meter <--> millimeter
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Paste into/from Saber and Windows Clipboard fails 
(TKS0079614)

A problem with the clipboard had prevented the copy of text from an external 
application into a Saber application (including Scope). 

This issue has been resolved in Saber Version Y-2006.06.

Poor performance (TKS0050410, TKS0040095, TKS0059694, 
TKS0065287)

Saber Harness was slow when the repository was installed across a WAN. For 
additional information on how to improve performance, see “Improved Saber 
Harness CVC Performance” on page 51.

This issue has been resolved in Saber Version Y-2006.06.

9000087026 Shared symbol netlister bug

9000086808 Probe displays wrong results for new design

9000086704 Merge problem for the .ai_hrndsn file when checking in

9000086687 Check in does not work and does not return any error message. Data loss!

9000085485 Saber simulator: bug: missing and inaccurate poles from pole/zero analysis

9000083336 Multiple open designs in SaberBundle

9000081198 Probes in new design give error message from old design

9000081168 don't zoom to fit x-axis when moving or re-sizing probe window

9000080858 Pressing <delete> key after selecting category stack traces or deletes parts

9000080836 Creating new top category causes stack trace and fails to create category

9000078907 Saber crashes on alter

9000074994 simulator selection in sketch does not work properly

9000073117 Can’t use shared inline again

9000069645 Assembly selection in PPE

9000062093 Data disappears from design list

9000043982 Problem moving shared inline

9000035906 When renaming a variant in a CVC design, got an assembly error

Table 8 Resolved Saber STARs (Continued)

STAR ID Title
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Can't save Experiment if already saved in previous invocation. 
(STAR 9000114021)

In the previous release of Saber Sketch, saving Experiments that contained the 
“Plot Signals In Scope” (scopeplot) item could result in an error and corruption 
of the Experiment data. The following message showed:

"Error: Can't read 'Form(value,.scopeplot,outline<name>)': 
no such element in array" 

This issue has been resolved in Saber Version Y-2006.06.

Get stack trace when adding information on connector 
passives (STAR 9000113564)

When adding information to a predefined value on a passive in Saber Harness, 
a stack trace occurred.

This problem was caused by a special case for which the parameter value was 
not properly checked. This issue has been resolved in Saber Version 
Y-2006.06.

Obtain errors about repository's lock (STAR 9000112939)

In Saber Harness, when a design was being worked on by multiple users, 
sometimes an error message showed an error message indicating that “cvs 
log” was waiting for the repository to be unlocked by another workspace.

This issue has been resolved in Saber Version Y-2006.06.

Saber Bundle crashes switching 2 designs (STAR 9000112126)

After switching between two workspaces, when you imported data to the 
workspace first opened, Saber terminated unexpectedly when attempting to 
close the design. 

This issue has been resolved in Saber Version Y-2006.06.

Crash when using close active design (STAR 9000112073)

Saber Harness and Saber Bundle crashed when closing the active design.

This issue has been resolved in Saber Version Y-2006.06.
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Drag & drop to different sheets with different components gives 
the same component from the “NEW” Parts gallery 
(STAR 9000109882)

In Saber Sketch, when you drag a symbol from one sheet in a design to 
another, the next drag operation places the first symbol again. 

A problem with the drag-and-drop operation from Parts Gallery into schematic s 
has been resolved in Saber Version Y-2006.06. 

regroup problem when moving object (STAR 9000109174)

In previous releases of Saber Harness, when you moved passive elements in 
bundle drawings, the element would re-associate when placed over a bundle 
segment. This caused unexpected behavior, rearranging elements and 
re-associating passive elements exchanged using the parts browser.

For more information, see “Association Behavior When Moving Passive 
Elements (STAR 9000109174)” on page 55.

This issue has been resolved in Saber Version Y-2006.06.

Problem with emag_coil_tlu.sin (STAR 9000109161)

An internal non-linear inductance calculation error has been resolved in Saber 
Version Y-2006.06. This will impact previous results with this template, which 
were incorrect.

CVS lock doesn’t disappear (STAR 9000106857)

When two users tried to check in designs at the same time, the lock was not 
released appropriately after the first check in completed. 

This issue has been resolved in Saber Version Y-2006.06.

Guide with Scope crashes in 2004.12 release 
(STAR 9000103093, 9000101101)

Upgrading to the latest Synopsys license file format could cause Saber 
applications to quit unexpectedly.

This issue has been resolved in Saber Version Y-2006.06.
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StateAMS: the condition ((a>b)|(a>c))&(b>c) leads to an error 
message (STAR 9000100181)

The StateAMS expression compiler had two problems:
■ Valid variables named i0 and j0 were treated as zero.
■ Valid conditional statements such as ((a>b)|(b>c))&(a>c) were causing a 

syntax error.

These issues have been resolved in Saber Version Y-2006.06.

When a new workspace is created the missing symbols window 
appears (STAR 9000099675)

In Saber Harness, when a new workspace was created the missing symbols 
window appeared even though the symbols were not missing. 

This issue has been resolved in Saber Version Y-2006.06.

Testify: cannot save tests/experiments (STAR 9000096125)

It was not possible to save the tests that were defined in Testify. Therefore it 
was almost impossible to use FMEA in Saber.

In release 2005.09, the test setup data in the Testify tool was not saved with the 
FMEA/Testify file. In release 2004.12, they were saved in a separate form file 
(extension ai_frm). The automatic loading and saving of the forms introduced in 
release 2005.09 filtered out the experiment data from the form file causing the 
test setup data to be lost. 

This issue has been resolved in Saber Version Y-2006.06 by saving the test 
setup data directly in the FMEA/Testify file. This provides a better 
compartmentalizing between Forms (ai_frm), Experiment Editor (ai_exp) and 
Testify data (ai_tst). Backward compatibility is ensured between release 
2004.12 and 2006.06: when opening a FMEA/Testify file created in 2004.12 or 
earlier, the 2006.06 tool fetches the test setup data in the form file.

Saber Bundle crashes in non CVC behavior (STAR 9000095187)

In a non-CVC stand alone Saber Bundle flow, Saber Bundle crashed if it was 
not closed before an import was made.

This issue has been resolved in Saber Version Y-2006.06.
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Data disappears from pass.prop.editor (STAR 9000094578)

In Saber Harness, passive data was lost without warning in the following ways:
■ The passive modifications were lost if there were CVC failures when the 

design was checked in.

This problem has been resolved in the Y-2006.06-3. You will see an error 
message, enabling you to manually correct the design. 

■ Auto Passives (where the auto field was marked) were removed after APS 
was run. The auto passive data was not qualified according to the current 
APS rules. However, the passives were removed without notification. 

This issue has been resolved in Saber Version Y-2006.06. Passives that are 
removed after running APS will now be listed in the APS report.

Import data from SDU does not show OK/Cancel & spaces in 
directory path fails (STAR 9000093494)

In the Scanned Data Utility, there were two problems with the import data 
function:
■ You could not open an *.ai_dat file located in a directory with a space in it
■ When you opened an *.ai_dat file, you were prompted to verify the axis scale 

and range. This window did not have the OK or Cancel buttons showing. You 
had to stretch the window in order to make them appear.

These issues have been resolved in Saber Version Y-2006.06. 

Predefined tests are lost, the experiment is not filled in. 
(STAR 9000093200)

In Testify, loading a predefined .ai_tst file loaded only the test name (in the Test 
Setup tab, the Test List is filled in) but did not load the test 
commands/definitions (in the Test Setup tab, the Selected Test was empty).

In release 2005.09, the test setup data in the Testify tool was not saved with the 
FMEA/Testify file. In release 2004.12, they were saved in a separate form file 
(extension ai_frm). The automatic loading and saving of the forms introduced in 
release 2005.09 filtered out the experiment data from the form file causing the 
test setup data to be lost. 

This issue has been resolved in Saber Version Y-2006.06 by saving the test 
setup data directly in the FMEA/Testify file. This provides a better 
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compartmentalizing between Forms (ai_frm), Experiment Editor (ai_exp) and 
Testify data (ai_tst). Backward compatibility is ensured between release 
2004.12 and 2006.06: when opening a FMEA/Testify file created in 2004.12 or 
earlier, the 2006.06 tool fetches the test setup data in the form file.

In addition to the previous problem, the following two issues have been 
resolved in Saber Version Y-2006.06:
■ In Testify, the Save command now works as expected. In release 2005.09 

and earlier, after saving data in A.ai_tst and then opening B.ai_tst, the Save 
command was saving the data in A.ai_tst instead of the expected B.ai_tst.

■ Interaction problems between Testify and the Experiment Editor have been 
addressed, such as untimely popup messages prompting you to save 
experiment data after a Save in the experiment editor.

Assembly tool corrupt when renaming assembly 
(STAR 9000091910)

When you rename an assembly in the default subharness, that subharness 
becomes corrupt, making it impossible to add new assemblies to it.

This issue has been resolved in Saber Version Y-2006.06.

The Catia reference part number shall be the part number in 
Saber. (STAR 9000090209)

Catia generates reference names for passives, bundle segments and bundle 
segment junctions that are more than ten characters long. However, DSI only 
accepts names with a maximum of ten characters. The names were manually 
corrected. However, when importing updated information, the links between 
existing passives, bundle segments and bundle segment junctions were lost, 
causing data to be lost.

This issue has been resolved in Saber Version Y-2006.06. Now, when importing 
to Saber Bundle, if the reference value is more than ten characters long, it will 
be modified to ensure that it is less than ten characters.
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chassis model: duplicate reference name (STAR 9000089860)

The Saber Harness netlister crashes with the following error message when 
the same gnd symbol is used more that once in a chassis model:

*** ERROR "EXT_DUP_INST_NAME" *** Instance name 'GND_M6' in 
schematic ' Left_Front_Door' is a duplicate. 

This issue has been resolved in Saber Version Y-2006.06.

Checked in values of .ai_hrndsn file was lost in second check-in 
(STAR 9000088845) 

An error was encountered when adding and removing some assemblies in a 
subharness in assembly tool. After the check-in, the changes did not appear in 
the .ai_hrndsn file. Specifically, the error appeared when you: 

1. Checked out a schematic sheet and the assembly data (as well as the 
.ai_hrndsn file), 

2. Modified the .ai_hrndsn file (to workaround the problem described in STAR 
9000086704), and checked in the assembly data.

3. Checked the repository file .ai_hrndsn,v file. At this point, the changes were 
still present. 

When you checked in the schematic sheet, the .ai_hrndsn file was modified 
back to its original status. 

This problem was caused by the manual edit workaround when attempting to 
overcome the problem described in STAR 9000086704. Since STAR 
9000086704 is resolved in this patch, there is no longer a need for this 
workaround. As a result, this issue is resolved in Saber Version Y-2006.06.

wirep model: meter <--> millimeter (STAR 9000088610) 

The unit conversion from millimeter to meter was not correct in the wirep 
template.

This issue has been resolved in Saber Version Y-2006.06.
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Shared symbol netlister bug (STAR 9000087026) 

The physical netlist generated by Harness showed an incorrect connection or 
crashed. This port connections problem for the shared symbol with the physical 
netlist has now been addressed.

This issue has been resolved in Saber Version Y-2006.06.

Probe displays wrong results for new design 
(STAR 9000086808)

Plotfiles remained open when you opened a new design in Saber Sketch, 
resulting in the probe window showing results from an older schematic, not the 
active one.

This issue has been resolved in Saber Version Y-2006.06. Plotfiles used for 
probes in Saber Sketch are now closed when a new design is opened or made 
active. This ensures that probes will, by default, show results only for the 
current design. If desired, results for another design may be displayed in a 
probe by manually opening the appropriate plotfile.

Merge problem for the .ai_hrndsn file when checking in 
(STAR 9000086704)

A problem arose with a renamed bundle drawing at check-in, even though only 
schematic sheets had been checked out. This was caused by another user 
performing a rename assembly in the assembly tool and checking in the 
changes. The schematic user’s .ai_hrndsn and assembly data file was not 
updated, and at check-in, the old version of these files were checked in on top 
of the latest version. This problem was caused by the assembly tool check in 
process and the update operation. 

This issue has been resolved in Saber Version Y-2006.06.

Check in does not work and does not return any error message. 
Data loss! (STAR 9000086687) 

In Saber-Harness 2005.09, the errors from CVS were ignored during the 
execution of a CVC operation. Users were not notified of the errors and the 
CVC operation was considered successful. This could cause data loss if users 
continued their work after the errors occurred.
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This issue has been resolved in Saber Version Y-2006.06. CVS errors are 
captured during CVC operations and users are notified of these errors. The 
CVC operation is not considered successful. 

Saber simulator: bug: missing and inaccurate poles from 
pole/zero analysis (STAR 9000085485)

AC analysis shows resonances, but pole zero analysis does not have a pole 
corresponding to those peaks.

This issue has been resolved in Saber Version Y-2006.06. Poles and zeros are 
now computed using a new and improved routine that provides better 
numerical accuracy.

Multiple open designs in Saber Bundle (STAR 9000083336) 

In the Saber releases V-2004.06 and earlier, it was possible to open multiple 
designs because Bundle drawings were a sheet in the harness design. 
However, from X-2005.09 and forward, where Saber Bundle is its own tool, 
where each drawing is its own design with links to the Harness design, this is 
not possible. If you opened multiple designs in X-2005.09, you get stack traces 
and it could not work.

Saber Bundle now supports multiple designs.

This issue has been resolved in Saber Version Y-2006.06.

Probes in new design give error message from old design 
(STAR 9000081198)

Plotfiles remained open when you opened a new design in Saber Sketch, 
resulting in error messages about the previous design for probes on the new 
design.

This issue has been resolved in Saber Version Y-2006.06. Probe plotfiles are 
now closed when a new design is opened in Saber Sketch. 
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don't zoom to fit x-axis when moving or re-sizing probe window 
(STAR 9000081168)

In Saber Sketch, if the X axis was zoomed in on a probe and you moved the 
probe, the X axis changed back to Zoom to Fit.

This issue has been resolved in Saber Version Y-2006.06. When a probe is 
moved in Saber Sketch, the current view is now maintained.

Pressing <delete> key after selecting category stack traces or 
deletes parts (STAR 9000080858)

In Saber Sketch, if you selected a category in Parts Gallery and pressed the 
Delete key, you received a stack trace. If you selected a part, collapsed all the 
nodes, minimized Parts Gallery, and then later selected a category and 
pressed the Delete key, the part you originally selected was deleted.

This issue has been resolved in Saber Version Y-2006.06. You can no longer 
use the Delete key to delete the active part or active category in Parts Gallery. 

To delete a part or a category, use the Delete command available from the 
pop-up menu.

Creating new top category causes stack trace and fails to create 
category (STAR 9000080836)

A stack trace error occurred when creating a new top-level category in Parts 
Gallery. 

This issue has been resolved in Saber Version Y-2006.06.

Saber crashes on alter (STAR 9000078907)

A defect was fixed in the Saber simulator that could cause an access violation 
when altering deeply nested structures containing arrays.

This issue has been resolved in Saber Version Y-2006.06.
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simulator selection in sketch does not work properly 
(STAR 9000074994)

In Saber Sketch when the selected simulator was Saber and you switched the 
simulator of choice to SaberHDL, occasionally not all of the menus were 
correctly switched. 

A latency problem when switching the active simulator caused the analysis 
forms to be out of sync with the selected simulator.

This issue has been resolved in Saber Version Y-2006.06.

Can’t use shared inline again (STAR 9000073117)

After removing a shared inline symbol, couldn’t share them again.

This issue has been resolved in Saber Version Y-2006.06.

Assembly selection in PPE (STAR 9000069645)

A stack trace occurred when editing a passive property on symbols in Saber 
Version X-2005.09. 

This issue has been resolved in Saber Version Y-2006.06.

Data disappears from design list (STAR 9000062093)

In Saber Harness, data disappeared from the design list. This occurred when 
access to the repository was lost after the design file lock was generated and 
before the design list was retrieved to the workspace.

This issue has been resolved in Saber Version Y-2006.06.

Problem moving shared inline (STAR 9000043982)

In Saber Harness, there was a problem moving a shared inline connector from 
one sheet to another. The Symbol > Shared Symbol > Remove command didn’t 
work on shared inline connectors. It was not possible to use the Undo 
command either.

This issue has been resolved in Saber Version Y-2006.06. If the shared inline 
symbols has three instances, when you use Symbol > Shared Symbol > 
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Remove on one instance, the other two shared instances keep their ref values. 
The Undo command also works now.

When renaming a variant in a CVC design, got an assembly 
error (STAR 9000035906)

In the Saber Harness Assembly tool, variants could be changed without 
checking out the assembly database. This potentially corrupted the assembly 
database.

This issue has been resolved in Saber Version Y-2006.06.
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CosmosScope Release Notes for Version Y-2006.06

This document is protected by copyright.

These release notes present the latest information about CosmosScope 
Version Y-2006.06 in the following sections:
■ Supported Environments
■ New Features, Enhancements, and Changes in Y-2006.06
■ Resolved STARs in Y-2006.06

Supported Platforms and Operating Systems 

This release of CosmosScope is compatible with the following platforms and 
operating systems. 

The following compilers were used for the associated platforms:

Table 1 Supported Platforms

Platform Operating System

SUN (Sparc OS5) 32-bit Solaris with Shared Library patch 111711-12 or 
later

HP9000 with PA-RISC 2.0
(HP8000), 32-bit

HP-UX 11.0 and 11.11 (11i)

PC/Linux, IA-32(x86), 32-bit
PC/Linux, AMD Opteron, 64-bit

RedHat Enterprise 3.0 with Update 5, RedHat 
Enterprise 4.0, SUSE 9.0

IBM RS6000, 32-bit AIX 5.3

PC/Windows, IA-32(x86), 32-bit Windows 2000 with Service Pack 3 or higher, 
Windows XP Professional

Table 2 Platforms and Compilers

Platform C C++ Fortran

SUN Solaris (Sparc) 5.9 5.9 5.9

HP9000 PA-RISC 2.0
(HP8000) using HP-UX 11

B.11.11.04 A.03.33 B.11.01.42

PC/Red Hat Linux gcc 3.3.6 g++ 3.3.6 g77 3.3.6

IBM RS6000 AIX VisualAge 6.0 VisualAge 6.0 xlfcmp 8.1.1.4
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New Features, Enhancements, and Changes

CosmosScope Version Y-2006.06 provides new features, enhancements, and 
changes as described in the following sections:
■ Updated .mask File Format
■ New Supported File Formats
■ Matlab R14 SP3 Support
■ Shooting Newton File Support
■ Setting Graph Preferences for Multiple Users
■ Signal Display Highlight Enhancement

GUI Enhancements

The GUI (Graphical User Interface) is updated in this release to help you work 
more efficiently and effectively. The following major GUI changes are in this 
release:
■ Two new main menu items: the Signal menu and Axis menu.

• The Signal menu includes several menu items that used to reside in the 
Graph menu. You can change the signal attributes and appearance with 
the new Signal menu items.

• The Axis menu also includes several menu items that used to reside in 
the Graph menu. You can set axis attributes and change the axis scale 
and view with the new Axis menu items.

Both menus are also available as pop-up menus when you right-click a 
signal or axis in the graph window. See the CosmosScope Reference 
Manual for more information.

PC/Windows 2000 MS Visual .NET MS Visual .NET Intel Visual Fortran 
9.0 with patch 24

Table 2 Platforms and Compilers

Platform C C++ Fortran
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■ Combined preferences for the following CosmosScope functions:

• Display

• XY

• Signal

• Graph

• Reader

• Signal Manager

• Measurement

• Application
■ Reorganized menus and forms

Plotfile Location and File Extension Display

CosmosScope can now display the path of a plotfile in the status bar, which 
appears at the bottom of the main window. Plotfile paths appear in the following 
instances:
■ When a signal is highlighted. If the path is too long, CosmosScope displays 

only the last part of the path that is closest to file name (for example, 
...ir1/dir2/dir3/filename).

■ When your mouse cursor moves over the plotfile names in the signal 
manager. If the path is too long, CosmosScope displays only the last part of 
the path that is closest to file name (for example,  
...ir1/dir2/dir3/filename).

Choosing the “Use file extension as name prefix” preference inserts the plotfile 
file extension before the signal label on the graph (for example, tr0:v(out) ). 
This preference is located in the Display tab of the Scope Preferences, which is 
accessible from Edit > Preferences... .

Matlab R14 SP3 Support

The SaberLink interface with CosmosScope now supports Matlab R14 SP3 on 
the Windows and Sun platforms.
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Shooting Newton File Support

CosmosScope now supports *.snac and *.snpn shooting newton files. They are 
handled as *.hb and *.pn files.

Setting Graph Preferences for Multiple Users

To set up Graph preferences for multiple users, create a common .scope_user 
file, then place it in a project directory accessed by all users and set the 
AI_SITE_PATH to this directory (either individually or in a global user setup 
file).

Signal Display Highlight Enhancement

Signals can now be highlighted by placing your mouse cursor on either the 
signal displayed in the graph region or the name of the signal in the legend. 
These options are available in the Display tab, which you can access by 
choosing Edit > Preferences... .

Resolved STARs

The Synopsys Technical Action Requests (STARs) listed in the following table 
are resolved in CosmosScope Version Y-2006.06.

Table 9 Resolved CosmosScope STARs 

STAR ID Title

9000084958 Plotfiles can now display file path information in the status bar at the bottom 
of the CosmosScope main window.

9000093203 Using the pf:write command to write a waveform to a plotfile that is 
created by the calculator did not work. This is now fixed.

9000105595 A core dump occurred when a Point to Point measurement was applied to 
a multi-member signal when using the “Visible X and Y range only” option 
in the Measurement Tool form. This problem was a result of setting this 
option and then zooming into the first segment of the signal that was not 
visible. This problem is now fixed.

9000108380 A stack trace erroneously appeared when moving one of two relative trace 
markers. This problem is now fixed.
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9000108866 When a plotfile was reloaded and a simulation was still running, the signal 
data point was displayed with triangle symbols when either no data point or 
only 1 data point was produced. Signal points were displayed with triangle 
symbols even after more data points were produced. This problem is fixed 
in this release.

Also, the reload function was broken in 2006.03. This is fixed in this release 
as well.

9000109487 The core dump that occurred when applying the “To Time Domain” option 
to a signal from an *.hb file is now fixed.

9000111399 When opening a plotfile, CosmosScope now flattens analog waveforms 
(reduces dimension) if they only contain 1 point per segment, regardless if 
a digital waveforms is in a plotfile.

9000113749 Two new shooting newton files, *.snac and *.snpn, are now supported as 
input to CosmosScope. They are handled as *.hb and *.pn files.

9000113770 The FFR API FSDB library (version 4.1) is now supported.

9000114415 Choosing “Zoom to fit” on the Y Axis only zoomed in partially. This problem 
is now fixed.

9000114601 Incorrect Crossing Measurement results were calculated when the crossing 
point was at a x value that also had multiple y values on either or both of the 
measured waveforms. This problem is now fixed.

9000116182 When first invoking CosmosScope, multiple graph windows all titled Graph0 
appeared, although only one of these windows was usable. This problem is 
now fixed.

Table 9 Resolved CosmosScope STARs (Continued)

STAR ID Title
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CosmosScope Release Notes for Version X-2006.03

This document is protected by copyright.

These release notes present the latest information about CosmosScope 
Version X-2006.03 in the following sections:
■ New Features, Enhancements, and Changes in Y-2006.06
■ Resolved STARs in Y-2006.06

New Features, Enhancements, and Changes

CosmosScope Version X-2006.03 provides new features, enhancements, and 
changes as described in the following sections:
■ Eye Diagram Enhancement
■ Updated .mask File Format
■ X Axis Changing Enhancement
■ Default X Axis Setting Enhancement
■ New Supported Matlab Versions
■ “All Plotfiles” File Type Filter Enhancement
■ Support for Concatenating FSDB Files
■ Graphical Point Reduction Enhancement
■ New Supported File Formats

Eye Diagram Enhancement

A new measurement option, Jitter Measurement, is added to the Measurement 
Menus under Time Domain, as well as a new option added to the Eye Diagram 
Measurement dialog box. See the CosmosScope Reference Manual for more 
information.
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Updated .mask File Format

The .mask file has the following new format:

FORMAT_VERSION=1
hex_MASK X1 X2 X3 Y1 Y2 Y3
rec_MASK X1 X2 X3 X4 Y1 Y2 Y3
dia_MASK X1 X2 X3 Y1 Y2 Y3
...

The first line in the file must be the format version number. The current version 
number is 1. The order of the data in Diamond Mask data line is changed from 
dia_MASK X1 X2 Y1 Y2 Y3 X3 to dia_MASK X1 X2 X3 Y1 Y2 Y3.

You can still import older .mask file versions that you used before this release.

X Axis Changing Enhancement

For analog signals in HSPICE, HSPICE Meas, and Saber pl type plotfiles, you 
can now change the X axis in the Signal List window.

Default X Axis Setting Enhancement

A new preference is added in the Reader tab of the CosmosScope preferences 
that allows you to set the default X axis. CosmosScope now reads and displays 
the waveform data according to that preference. Choose Edit > Scope 
Preferences... to access this new preference.

New Supported Matlab Versions

Matlab R14, R14 Service Pack 1, and R14 Service Pack 2 (Version 7.0 for all) 
is supported on the Windows and Sun platform versions in the SaberLink 
Interface with CosmosScope.

“All Plotfiles” File Type Filter Enhancement

Choosing “All Plotfiles” as the file type filter in the File > Open > Plotfiles... 
browser now displays all file types that CosmosScope can recognize and open.
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Support for Concatenating FSDB Files

A new preference is added to the Scope Preferences for the FSDB Reader: 
Concat Split Files or Do Not Concat Split Files. The default is to concatenate 
the split files. A split file is a file larger than 2GB, where the first file is named 
filename.fsdb and the split file is named filename_1.fsdb.

Also, a new command is added to the Calculator for concatenating two 
waveforms into a single waveform. The command is accessible from the Wave 
button and is called Concat. The Concat command takes the waveform in the X 
register and concatenates it to the waveform in the Y register. If the waveforms 
have the same name, the resulting waveform also has that name. If the 
waveforms have different names the resulting waveform are named using this 
format: concat(wfname1,wfname2).

Graphical Point Reduction Enhancement

A new option called “Signal Draw Point Reduction” is added to the Display Tab 
in the Graph Preferences, which allows you to determine when the graphical 
point reduction algorithms are run on the waveform. The default value is 
10,000, which means that any waveform with 10,000 or more points is passed 
through the point reduction algorithms and the unnecessary points are 
removed. This only effects the graphical display of the waveform and does not 
change the waveform values passed to the measurement routines. To see all 
points of the waveform, set the threshold value to 0.

Note: For very large waveforms, setting the threshold to 0 will cause an 
increase in memory usage and time it takes to draw the waveform on the graph.

New Supported File Formats

CosmosScope can now recognize and open the following new file formats:
■ HSPICE RF HBLIN output (*.hl*)
■ HSPICE DC Match and DC Sense output
■ HSPICE Monte Carlo output (*.mcs, *.mca, and *.mct)
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Resolved STARs

The Synopsys Technical Action Requests (STARs) listed in the following table 
are resolved in CosmosScope Version X-2006.03.

Table 10 Resolved CosmosScope STARs 

STAR ID Title

TKS0064634 The “All Plotfiles” file type filter option is added with the other supported file 
types found in the File > Open... dialog box. Choosing “All Plotfiles” shows 
all the supported file types that CosmosScope can recognize and open.

TKS0074104 A preference is added for the HSPICE measurement file reader that allows 
you to set the default x axis to either “index” or the swept parameter.

9000014381 Matlab R14, R14 Service Pack 1, and R14 Service Pack 2 (Version 7.0 for 
all) is supported on the Windows and Sun platform versions in the 
SaberLink interface with CosmosScope.

9000044452 CosmosScope now supports the HSPICE RF HBLIN analysis output files 
(*.hl0) and related touchstone files.

9000046564 You can now change the X axis for analog signals in the Signal List window.

9000068985 A new preference is added to the Scope Preferences for the FSDB Reader, 
which allows you to concatenate split FSDB files.

9000077105 The first line of .mask files now specifies the mask file format version.

9000083124 Eye diagrams are now trimmed at the end of the cycle period time.

9000083665 CosmosScope core dumped when opening multiple tones HSPICE RF 
envelope files. This problem is now fixed.

9000084787 The Match button in the Signal Manager and Signal List windows did not 
plot the signals in the correct views for complex waveforms. This problem is 
now fixed.

9000085161 You can now delete all the measurements on a graph by selecting Graph > 
Delete All Measurements from the CosmosScope GUI menu bar.

9000085270 Point to point measurements failed in the digital region (Trace Region Mode) 
if either of the two signal was a constant. This problem is now fixed.

9000085443 In previous releases, selecting multiple signals in the digital region with the 
<mouse button + shift key> did not work when more than 10 signals existed 
in a region. This problem is now fixed.

9000086204 The VCD reader now supports VCD files that do not contain the date, 
version, and timescale header information.

9000086609 The Ref. Delay Level field in the Delay Measurement dialog box now is 
called “Ref. Level”.
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9000086627 When using the Vertical Marker Measurement function to apply the Vertical 
Marker Measurement to all the signals on a current graph twice, a failure 
occurred during the second measurement. This problem is fixed in this 
release.

9000087030 CosmosScope now supports the DC match and DC sense waveforms in 
HSPICE output files.

9000087838 The values that appear in the Measurement Results form are now updated 
correctly when Vertical Markers are moved.

9000089873 You can now create scripts for all the following RF Tool items:
■ Point Trace
■ Noise Circle
■ Stability Circle
■ Operating Power Gain Circle
■ Available Power Gain Circle
■ VSWR circle
■ Parameter Conversion

9000089874 The following enhancements are included in this STAR:
■ Smith Charts now include pop-up segment information when you move 

your mouse over the waveform on a graph. To enable this feature, select 
“Waveform and Legend” for “signal highlight on” in the Graph 
Preferences. 

■ For all graph types, if the signal is a multi-member signal, you can get 
pop-up segment information even if the signal only has one member. 

■ You can now choose “Members...” from the pop-up menu that appears 
when right-clicking a signal name in the legend, even if a multi-member 
signal has only one member. 

■ VSWR circles now have names with the VSWR value from this release. 
For example: VSWRout=1.4 or VSWRin=1.9.

9000090253 The measurement results from the following RF Tool items are 
automatically refreshed when the plot file is reloaded:
■ Point Trace
■ Noise Circle
■ Stability Circle
■ Operation Power Gain Circle
■ Available Power Gain Circle
■ VSWR Circle
■ Parameter Conversion

9000090259 The noise figure and power gain ratio waveforms are now set to be of type 
“power” so that the conversion to the dB view uses the correct calculation 
factors.

Table 10 Resolved CosmosScope STARs 

STAR ID Title
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9000090280 CosmosScope miscalculated noise circles when using the RF Tool. This 
problem is now fixed.

9000090575 CosmosScope now supports the following HSPICE Monte Carlo analysis 
result measurement files: *.mcs, *.mca, and *.mct.

9000091709 Unexpected Ref. Trigger results of Delay Measurements occurred in 
CosmosScope. This problem is now fixed.

9000094496 A new option called “Signal Draw Point Reduction” is added to the Display 
Tab in the Graph Preferences, which allows you to determine when the 
graphical point reduction algorithms are run on the waveform.

9000100903 An error occurred when a missing variable called “lseg” that appeared when 
apply DeltaX measurement on a multi-member waveform. This problem is 
now fixed.

9000102193 CosmosScope now supports HSPICE RF Shooting-Newton analysis 
results. The following file extensions are supported:
■ .sn0 for time-domain data (same format as .tr0)
■ .snf0 for frequency-domain data (same format as .hb0)
■ .snft0 for fft'd time-domain data (same format as .ft0)
■ .msn0 for shooting-Newton measurements (same format as .mt0)

9000104210 The problem of Point to Point measurement at the same x value for both 
signals is fixed.

Table 10 Resolved CosmosScope STARs 

STAR ID Title
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